








Kata Pengantar 

 

Design Web merupakan salah satu faktor yang menunjang user atau pengunjung betah untuk 

selalu mengunjungi website kita. Untuk itu design yang baik menjadi penti ng sifatnya.  

Artisteer dengan kemampuannya dapat mengakomodir semua itu tanpa kemampuan design, 

tanpa harus belajar photoshop, Jquery dan pemrograman kita dapat membuat design template 

yang luar biasa. Dengan beberapa klik design template langsung tersedia. 

Besar harapan penulis isi dari buku ini dapat membantu pemula untuk dapat membuat design 

template sendiri dan juga merancangn menggunakan artisteer. 
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Bab 1 

Pendahuluan 
 

Teknologi saat ini berkembang dengan sangat pesatnya, salah satu ciri perkembangan 

teknologi adalah dengan semakin mudahnya komunikasi antar manusia dibelahan bumi 

mana pun sehingga dengan adanya teknologi tidak terjadi lagi pemusatan ilmu hanya 

pada masyarakat perkotaan tetapi sudah mencapai daerah-daerah terpencil di Indonesia. 

Sesuai dengan Undang-undang No 11 tahun 2008 tentang informasi dan transaksi 

elektronik yaitu pada Bab II pasal 4 yang isinya : Pemanfaatan Teknologi Informasi dan 

Transaksi elektronik dilaksanakan dengan tujuan untuk : 

a. Mencerdaskan kehidupan bangsa sebagai bagian dari masyarakat informasi dunia; 

b. Mengembangkan perdagangan dan perekonomian nasional dalam rangka 

meningkatkan kesejahteraan masyarakat; 

c. Meningkatkan efektifitas dan efisiensi pelayanan public; 

d. Membuka kesempatan seluas-luasnya kepada setiap orang untuk memajukan 

pemikiran dan kemampuan di bidang penggunaan dan pemanfaatan teknologi 

informasi seoptimal mungkin dan bertanggung jawab; dan 

e. Memberikan rasa aman, keadilan dan kepastian hokum bagi pengguna dan 

penyelenggara teknologi informasi. 

Pada buku ini akan dibahas bagaimana menyajikan informasi kepada masyarakat dengan 

design yang ringkas dan mudah dengan menggunakan tools aplikasi artisteer. Dengan 

memahami tata cara design yang baik dalam penyajian maka kentrampilan kita akan 

meningkat yaitu : 

a. Menggali ide-ide kreatif design web yang keren. 

b. Menyesuaikan design dengan kebutuhan sehingga web kita akan nampak profesional  

c. Tanpa belajar photoshop, css, HTML kita langsung terampil membuat design 

website. 

d. Terampil dalam menghasilkan gagasan, prototype dan website cepat untuk klien dan 

teman-teman. 

e. Otomatis mudah memecahkan masalah dengan gambar aliasing disertai web 

kompatibilitas dan rincian lain yang membutuhkan waktu dan pengetahuan. 
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Sebelum lebih dalam tentang bahasan buku ini ada baiknya kita herapaham tentang 

internet dan bagiannya. Pengertian Internet Adalah singkatan dari (Interconnected 

Computer Networks) atau bisa didefinisikan sebagai Jaringan Komputer yang tiada batas 

yang menjadi penghubung pengguna komputer satu dengan pengguna komputer lainnya 

serta dapat berhubungan dengan komputer di sebuah wilayah ke wilayah di penjuru 

dunia, dimana di dalam jaringan tersebut mempunyai berbagai macam informasi serta 

fasilitas layanan internet browsing atau surfing. Istilah ini lebih dikenal dengan “online” 

di internet. Pekerjaan ini bisa di ibaratkan seperti kita berjalan-jalan di tempat hiburan 

sembari melihat-lihat ke toko-toko namun tidak membeli jualan tersebut. 

Internet merupakan sistem global jaringan komputer yang berhubungan menggunakan 

standar Internet Protocol Suite (TCP / IP) untuk melayani miliaran pengguna di seluruh 

dunia. Ini adalah jaringan dari jaringan yang terdiri dari jutaan jaringan pribadi, umum, 

akademik, bisnis, dan jaringan pemerintah, dari lokal ke lingkup global, yang 

dihubungkan oleh sebuah kode array yang luas dari teknologi jaringan elektronik, 

nirkabel dan optik. Internet juga dapat didefinisikan sebagai interkoneksi seluruh dunia 

komputer dan jaringan komputer yang memfasilitasi sharing atau pertukaran informasi di 

antara pengguna. 

Elektronik mail (E-mail) fitur ini dipakai sebagai media berkirim surat dengan orang lain, 

tanpa ada batasan waktu, ruang bahkan birokrasi dunia maya yakni kegiatan mencari data 

atau informasi tertentu di internet Catting fasilitas ini digunakan untuk berkomunikasi 

secara langsung dengan orang lain di internet. Pada umumnya fasilitas ini sering 

digunakan untuk bercakap-cakap atau ngobrol di internet world wide web (www) dengan 

world wide web (www) ini kita bisa mengambil, memformat, dan menampilkan 

informasi (termasuk teks, audio, grafik serta video dengan menggunakan hypertext links. 

Mailing list, fitur ini digunakan untuk dapat berdiskusi secara elektronik dengan 

menggunakan E-mail ke sesama pengguna email. Mailing list ini digunakan untuk 

bertukar infomasi, pendapat dan lain sebagainya. Newsgroup digunakan untuk 

berkoferensi jarak jauh, sehingga kita bisa menyampaikan pendapat dan tanggapan dalam 

internet. Download merupakan proses mengambil file dari komputer lain melalui internet 
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ke komputer di rumah. Upload merupakan proses meletakkan file dari komputer kita ke 

komputer lain melalui internet File transfer protocol (FTP) fungsi ini digunakan untuk 

melakukan pengambilan arsip atau file secara elektroniok atau transfer file dari satu 

komputer ke komputer lain di internet. 

Beberapa server di internet telah menyediakan file atau dokumen yang dapat untuk di 

gandakan oleh para penggunanya secara gratis. Telnet fasilitas ini digunakan untuk 

masuk ke system computer tertentu dan bekerja pada system komputer lain. Ghoper 

fungsi ini digunakan untuk menempatkan informasi yang di simpan pada internet servers 

dengan menggunakan hirarkhi dan pengguna bisa mengambil informasi tersebut secara 

mudah dan tentunya gratis. 

Web adalah halaman informasi yang disediakan melalui jalur internet sehingga bisa 

diakses di seluruh dunia selama terkoneksi dengan jaringan internet namun begitu dapat 

pula diakses tidak menggunakan jalur internet melainkan intranet. Definisi lain tentang 

web adalah salah satu alat komunikasi online yang menggunakan media internet dalam 

pendistribusiannya. Apapun bahasanya, yang pasti kita semua setuju bahwa website 

merupakan kumpulan halaman yang menampilkan informasi data teks, data gambar diam 

atau gerak, data animasi, suara, video dan atau gabungan dari semuanya, baik yang 

bersifat statis maupun dinamis yang membentuk satu rangkaian bangunan yang saling 

terkait dimana masing-masing dihubungkan dengan jaringan-jaringan halaman 

(hyperlink). 

 

 

Secara terminologi website adalah kumpulan dari halaman-halaman situs, yang biasanya 

terangkum dalam sebuah domain atau subdomain, yang tempatnya berada di dalam 

World Wide Web (WWW) di Internet. WWW terdiri dari seluruh situs web yang tersedia 

kepada publik. Halaman-halaman sebuah situs web  (web page) diakses dari sebuah URL 

(Uniform Resource Locator) yang menjadi “akar” (root), yang disebut homepage 

(halaman induk; sering diterjemahkan menjadi “beranda”, “halaman muka”), URL 

merupakan suatu inovasi dasar bagi perkembangan sejarah Internet. URL pertama kali 

diciptakan oleh Tim Berners-Lee pada tahun 1991 agar penulis-penulis dokumen-
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dokumen dapat merujuk pranala ke Waring Wera Wanua atau World Wide Web. Sejak 

1994, konsep URL telah dikembangkan menjadi istilah Uniform Resource Identifier 

(URI) yang lebih umum sifatnya. Walaupun demikian, istilah URL masih tetap 

digunakan secara luas URL ini mengatur web page untuk menjadi sebuah hirarki, 

meskipun hyperlink-hyperlink yang ada di halaman tersebut mengatur para pembaca dan 

memberitahu mereka susunan keseluruhan dan bagaimana arus informasi ini berjalan. 

 

Sebuah Web page adalah dokumen yang ditulis dalam format HTML (Hyper Text 

Markup Language), yang hampir selalu bisa diakses melalui HTTP, yaitu protokol yang 

menyampaikan informasi dari server website untuk ditampilkan kepada para pemakai 

melalui web browser. Semua publikasi dari website-website tersebut dapat membentuk 

sebuah jaringan informasi yang sangat besar. Web page layaknya sebuah buku yang 

dapat menampung berbagai informasi tentang banyak hal baik bersifat komersil maupun 

non komersil. Melalui media web inilah seseorang dapat memberikan informasi tertentu 

kepada orang lain yang berada di seluruh dunia. 

 

Website mulai dikenal di Indonesia sekitar tahun 1998, dimana hanya perusahaan besar 

saja yang mampu memilikinya. Pada saat itu, website merupakan sebuah teknologi yang 

cukup mahal untuk dimiliki. Sehingga banyak pengusaha maupun produsen 

mengurungkan niat mereka untuk dapat memiliki media promosi ini. Langkanya 

penyedia jasa pembuatan web yang menawarkan harga murah membuat keinginan 

perusahaan-perusahaan tersebut untuk memiliki sebuah website murah hanya menjadi 

sebuah mimpi. Website sekarang ini menjadi trend di kalangan masyarakat dunia. Tidak 

heran jika di jaman sekarang orang-orang menilai perusahaan yang tidak mempunyai 

website itu dianggap perusahaan kecil, perusahaan yang kurang maju, dan sebagainya. 

Terlebih lagi, hampir setiap remaja Indonesia mempunyai website blog / personal blog 

karena memang blog sudah dimasukkan di kurikulum pendidikan di Indonesia, terutama 

di jenjang SMA/SMU/SMK sederajat. 

 

Sekarang ini terdapat hampir milyaran halaman website yang memeriahkan dunia maya. 

Sebagian besar dari website tersebut adalah web komersial yang bersifat bisnis dan 
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perdagangan. Rupanya media promosi dalam bentuk website sangat berperan penting 

dalam dunia usaha. Buktinya akhir-akhir ini banyak pengusaha besar maupun kecil telah 

menggunakan website sebagai salah satu media promosi dalam memasarkan produk 

ataupun jasa. Fungsi website yang tidak hanya sebagai sarana promosi melainkan juga 

sebagai upaya untuk meningkatkan prestise (gengsi) dari suatu perusahaan telah membuat 

banyak pengusaha berani mengeluarkan biaya yang cukup tinggi untuk memiliki media 

online ini. 

Untuk menampilkan website yang menarik diperlukan design website yang menarik pula, 

Desain Web adalah jenis desain grafis yang ditujukan untuk pengembangan dan styling 

obyek lingkungan informasi Internet untuk menyediakan dengan fitur konsumen high-

end dan kualitas estetika. Definisi yang ditawarkan memisahkan desain web dari 

pemrograman web, menekankan fitur fungsional dari sebuah situs web, serta desain 

posisi web sebagai semacam desain grafis.  

 

Secara umum fungsi situs web adalah sebagai berikut: 

1. Fungsi Komunikasi 

Situs web tang berfungsi sebagai komunikasi pada umumnya adalah web 

dinamis.Karena dibuat menggunakan pemrograman web(server side) maka dilengkapi 

dengan fasilitas yang memberikan fungsi-fungsi komunikasi seperti web mail , 

formanthec, chatting, forum dll. 

 

2. Fungsi Informasi 

Menekankan pada kualitas konten,karena tujuan situs ini mnyampaikan isinya 

Sebaiknya berisi teks dan grafik Fasilitas yang memberikan fungsi informasi, news, 

file, company, library, prefences dll. 

3. Fungsi Entertainment 

Sebagai sarana hiburan/penggunaan animasi gambar dan element bergerak 

dapatmeningkatkan mutu persentasi design, meski tetap harus mempertimbangkan 

kecepatan downloadnya.Contoh fungsi Entertaiment: game online, film online, music 

online dll. 
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4. Fungsi Transaksi 

Situs web dapat dijadikan transaksi bisnis baik barang jasa,dll. situs web 

menghubungkan perusahaan konsumen dan komunitas tertentu melalui sarana 

elektronik.Pembayarannya bisa memudahkan kartu kredit, transfer ataupun 

membayar langsung. 
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Bab 2 

Content Management System (CMS) 
 

 

 

CMS secara sederhana dapat diartikan sebagai: Sebuah sistem yang memberikan kemudahan 

kepada para penggunanya dalam mengelola dan mengadakan perubahan isi sebuah website 

dinamis tanpa sebelumnya dibekali pengetahuan tentang hal-hal yang bersifat teknis. Dengan 

demikian, setiap orang, penulis maupun editor, setiap saat dapat menggunakannya secara 

leluasa untuk membuat, menghapus atau bahkan memperbaharui isi website tanpa campur 

tangan langsung dari pihak webmaster. 

Sedangkan menurut wikipedia, CMS adalah perangkat lunak yang memungkinkan seseorang 

untuk menambahkan dan/atau memanipulasi (mengubah) isi dari suatu situs Web. Umumnya, 

sebuah CMS terdiri dari dua elemen: 

1. Aplikasi manajemen isi (Content Management Application) 

2. Aplikasi pengiriman isi (content delivery application)  

 

Elemen CMA (Content Management Application) memperbolehkan si manajer isi yang 

mungkin tidak memiliki pengetahuan mengenai HTML (HyperText Markup Language), untuk 

mengatur pembuatan, modifikasi, dan penghapusan isi dari suatu situs Web tanpa perlu 

memiliki keahlian sebagai seorang Webmaster.  

Elemen CDA (content delivery application) menggunakan dan menghimpun informasi-

informasi yang sebelumnya telah ditambah, dikurangi atau diubah oleh si empunya situs web 

untuk meng-update atau memperbaharui situs Web tersebut. Kemampuan atau fitur dari sebuah 

sistem CMS berbeda-beda, walaupun begitu, kebanyakan dari software ini memiliki fitur 

publikasi berbasis Web, manajemen format, kontrol revisi, pembuatan index, pencarian, dan 

pengarsipan. 
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Berikut dibawah ini pemanfaatan CMS: 

- Website perusahaan, bisnis, organisasi atau komunitas. 

- Portal 

- Galeri foto 

- Aplikasi E-Commerce. 

- Mengelola website pribadi / blog. 

- Dan lain-lain. 

 

Karena CMS memisahkan antara isi dan desain, konsistensi tampilan dapat senantiasa dijaga 

dengan baik. Setiap bagian dari website dapat memiliki isi dan tampilan yang berbeda-beda, 

tanpa harus khawatir kehilangan identitas dari website secara keseluruhan. Oleh karena semua 

data disimpan dalam satu tempat, pemanfaatan kembali dari informasi yang ada untuk berbagai 

keperluan dapat dengan mudah dilakukan. 

 

CMS juga memberikan kefleksibelan dalam mengatur alur kerja atau workflow dan hak akses, 

sehingga memperbesar kesempatan berpartisipasi dari pengguna dalam pengembangan website. 

Hal ini akan sangat menguntungkan bila website yang dikelola memiliki kompleksitas yang 

tinggi dan mengalami kemajuan yang cukup pesat. 

Macam-macam CMS Open Source sangatlah banyak, berikut ini beberapa CMS yang sangat 

popular saat ini: 

1. Drupal 

Drupal adalah content management system dan blogging engine yang pertama kali 

dikembangkan oleh Dries Buytaert sebagai sebuah sistem bulletin board. Sekarang ini Drupal 

banyak digunakan oleh website-website yang memiliki traffic tinggi dan memiliki tingkat 

penanganan sebuah website yang hirarki yang kompleks. 

Website download : Drupal.org 
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2.  Mambo 

Mambo pada awalnya disebut Mambo Open Source atau MOS adalah free software atau open 

source content managemen system yang digunakan untuk membuat dan mengatur website 

melalui sebuah interface yang simple. Sekarang ini mambo banyak dipilih dan digunakan 

karena kemudahan yang diberikan untuk mengoperasikannya. Seperti hampir semua CMS yang 

digemari mambo memiliki kemampuan templating atau kemampuan untuk mengganti tampilan 

website tanpa harus melakukan upload/perubahan kontent. mambo menyediakan fasilitas dan 

komponenkomponen seperti shopping chart (menggunakan komponen virtue mart), photo 

gallery, forum, pools, calendars website searching, multi bahasa dan lain-lain. Hampir sebagian 

besar website yang kami bangun menggunakan Mambo sebagai pilihan CMS. Sebuah 

kebanggaan bagi Indonesia karena salah satu CoreDev Team Mambo adalah orang Indonesia 

asli. 

 

3. Joomla 

Kata Joomla diambil dari sebuah kata dari suku Swahili yaitu Jumla yang berarti “menjadi 

kesatuan” bisa dikatakan memiliki kemampuan sama dengan Mambo, karena CMS ini code 

awalnya Joomla! 1.0.0 menggunakan code Mambo 4.5.2.3. Banyak komponen Mambo juga 

dapat digunakan di sebagai Plugin Joomla begitu juga sebaliknya. Kemampuan memilih plugin 

yang tepat untuk setiap release yang dipilih melalui proses riset mengindari terjadinya konflik 

atau crash karena banyak plugin memerlukan penyesuaian disetiap versinya. 

Website download : Joomla.org 
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4. WordPress 

CMS terpopuler saat ini? WordPress! Tidak terbantah lagi kalau CMS yang satu ini digunakan 

oleh begitu banyak website terutama web-blog, CMS ini cocok sekali digunakan untuk website 

berbasis news atau berita.  Kesederhanaan administrator sidenya membuat CMS ini sangat fasih 

digunakan untuk pemula sekalipun. Kemampuan templatingnya sangat digemari juga karena 

sangat mudah dimengerti. Mengejutkan ketika sekarang wordpress dengan pluginsnya yang 

berkembang pesat sehingga dapat digunakan untuk kebutuhan CMS corporate bahkan 

digunakan sebagai simple shoping chart. Kelebihan lain dari CMS ini sangat mudah dioptimasi 

menjadi sebuah website yang search engine friendly dengan tag sistemnya, friendly url, custom 

meta, auto ping, sitemap dan rss-nya. Penggunaan CMS ini kami sangat sarankan untuk website 

berskala kecil atau website berbasis berita dan weblog.  

WordPress memiliki banyak keunggulan dan fitur untuk dunia blog, antara lain : 

- Gratis. Untuk mendapatkan perangkat lunak WordPress hanya perlu mengunduh dari 

situsnya tanpa dipungut biaya, bahkan untuk blog komersial sekalipun. 

- Berbasis kode sumber terbuka (open source). Pengguna dapat melihat dan memperoleh 

barisan kode-kode penyusun perangkat lunak WordPress tersebut secara bebas, 

sehingga pengguna tingkat lanjut yang memiliki kemampuan pemrograman dapat bebas 

melakukan modifikasi, bahkan dapat mengembangkan sendiri program WordPress 

tersebut lebih lanjut sesuai keinginan. 

- Template atau desain tampilannya mudah dimodifikasi sesuai keinginan pengguna. 

Sehingga apabila pengguna memiliki pengetahuan HTML yang memadai, maka 

pengguna tersebut dapat berkreasi membuat template sendiri. Pengguna yang tidak 

mengerti HTML, tentu saja masih dapat memilih ribuan template yang tersedia di 

internet secara bebas, yang tentu saja gratis. 

- Pengoperasiannya mudah. 
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- Satu blog WordPress, dapat digunakan untuk banyak pengguna (multi user). Sehingga 

WordPress juga sering digunakan untuk blog komunitas. Anggota komunitas tersebut 

dapat berperan sebagai kontributor. 

- Jika pengguna sebelumnya telah mempunyai blog tidak berbayar, misalnya di alamat 

Blogger, LiveJournal, atau TypePad, pengguna dapat mengimpor isi blog-blog tersebut 

ke alamat hosting blog pribadi yang menggunakan perangkat lunak WordPress. Dengan 

demikian pengguna tidak perlu khawatir isi blog yang lama akan menjadi sia-sia setelah 

menggunakan perangkat lunak WordPress. 

- Selain pengguna yang banyak, banyak pula dukungan komunitas (community support) 

untuk WordPress. 

- Tersedia banyak plugin yang selalu berkembang. Plugin WordPress sendiri yaitu sebuah 

program tambahan yang bisa diintegrasikan dengan WordPress untuk memberikan 

fungsi-fungsi lain yang belum tersedia pada instalasi standar. Misalnya plugin anti-

spam, plugin web counter, album foto. 

- Kemampuan untuk dapat memunculkan XML, XHTML, dan CSS standar. 

- Tersedianya struktur permalink yang memungkinkan mesin pencari mengenali struktur 

blog dengan baik. 

- Kemungkinan untuk meningkatkan performa blog dengan ekstensi. 

- Mampu mendukung banyak kategori untuk satu artikel. Satu artikel dalam WordPress 

dapat dikatogorisasikan ke dalam beberapa kategori. Dengan multikategori, pencarian 

dan pengaksesan informasi menjadi lebih mudah. 

- Fasilitas Trackback dan Pingback. Juga memiliki kemampuan untuk melakukan 

otomatis Ping (RPC Ping) ke berbagai search engine dan web directory, sehingga 

website yang dibuat dengan Wordpress akan lebih cepat ter index pada search engine. 

- Fasilitas format teks dan gaya teks. WordPress menyediakan fitur pengelolaan teks yang 

cukup lengkap. Fitur – fitur format dan gaya teks pada kebanyakanperangkat lunak 

pengolah kata seperti cetak tebal, cetak miring, rata kanan, rata kiri, tautan tersedia di 

WordPress. 

- Halaman statis (Halaman khusus yang terpisah dari kumpulan tulisan pada blog). 

- Mendukung LaTeX. 
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- Mempunyai kemampuan optimalisasi yang baik pada Mesin Pencari (Search Engine 

Optimizer) 

 

Website : WordPress.org dan WordPress.com 

 

5. Blogger 

Blogger adalah sebuah layanan publikasi blog yang dibuat oleh Pyra Labs dan diakusisi oleh 

Google pada tahun 2003. Secara umum, blog yang dihost oleh Google berada di bawah 

subdomain blogspot.com. Blogger memperbolehkan penggunanya untuk mempublikasikan 

blognya di server lain, melalui FTP hingga 1 Mei 2010. Setelah tanggal tersebut, semua blog 

harus disimpan di server Google, meskipun pengguna dapat menggunakan alamat situsnya 

sendiri dengan fitur Custom URL. 

 

Pada 23 Agustus 1999, Blogger diluncurkan oleh Pyra Labs. Sebagai salah satu perangkat 

publikasi blog pertama di dunia, Blogger berperan dalam mempopulerkan format blog di dunia. 

Pada Februari 2003, Pyra Labs diakusisi oleh Google, membuat sejumlah fitur premium 

Blogger yang sebelumnya dikomersialkan Pyra Labs menjadi layanan yang sepenuhnya gratis. 

Pada Oktober 2004, salah satu pendiri Pyra Labs, Evan Williams, mengundurkan diri dari 

Google. 

 

Pada tahun 2004, Google membeli Picasa, dan mengintegrasikannya dengan Blogger sehingga 

pengguna Picasa dapat mempublikasikan koleksi foto miliknya ke situs blognya. 

Pada 9 Mei 2004, Blogger memperkenalkan beberapa perubahan besar pada sistem publikasi 

blognya, menambahkan fitur seperti templat yang memenuhi standar web, halaman arsip 

individual untuk masing-masing posting dan komentar, serta fitur posting melalui email. 

 

Pada 14 Agustus 2006, Blogger meluncurkan versi terbarunya dalam tahap beta, yang diberi 

nama kode "Invader". Versi terbaru ini memigrasikan pengguna Blogger ke server milik 

Google dan menambahkan beberapa fitur baru. Pada Desember 2006, versi baru ini keluar dari 
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tahap beta. Mei 2007, Blogger selesai memigrasikan semua data penggunanya ke server 

Google. 

Sebagai bagian dari desain ulang Blogger di tahun 2006, semua blog yang ada di Blogger 

dimigrasikan ke server Google. Blogger mengklaim bahwa dengan migrasi tersebut, layanan 

mereka lebih stabil karena kualitas server yang dimiliki Google lebih baik dari sebelumnya. 

 

Seiring dengan migrasi layanan Blogger ke server Google ini, beberapa fitur baru 

diperkenalkan, meliputi manajemen label, antarmuka penataan layout template dengan cara 

geser-dan-letakkan (drag-and-drop), izin pembacaan blog (untuk membuat blog-blog pribadi) 

dan opsi web feed yang baru. Lebih lanjut, kini setiap blog diperbaharui secara dinamis, 

berbeda dengan sebelumnya di mana setiap posting atau komentar baru diperlakukan dengan 

menulis ulang file HTML. 

 

Pada September 2009, Google memperkenalkan fitur baru sebagai bagian dari perayaan ulang 

tahunnya yang kesepuluh. Fitur tersebut meliputi tampilan baru untuk menulis post, 

penyempurnaan penanganan gambar, dan implementasi berbasis Google Docs lainnya, seperti: 

- Menambahkan lokasi penulisan di post. 

- Penanggalan tulisan ditentukan pada saat publikasi, bukan saat pembuatan. 

- Pengubahan tautan di mode penulisan (Compose mode). 

- Layanan penuh bagi Safari 3. 

- Tampilan pratayang yang menampilkan post dengan perkiraan lebar tulisan dan ukuran 

font ketika tulisan tersebut dipublikasikan. 

- Toolbar yang baru dengan tampilan khas Google, waktu pemuatan yang lebih cepat, dan 

tombol Undo serta Redo. 

Pada tahun 2010, Blogger memperkenalkan template baru dan melakukan desain ulang 

situsnya. 

Pada tahun 2013, Blogger mengupdate fitur fiturnya salah satunya fitur komentar dan integrasi 

pada google+, ada beberapa fitur baru diantaranya : 

- Design Antar Muka yang diperbaharui pada tahun 2012 

- Integrasi langsung dengan google adsense, tahun 2012 

- Integrasi dengan google+ pada kotak komentar dan posting, tahun 2013 
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Fitur mobile template yang mana kita bisa mendesign atau memilih design yang telah 

disediakan sehingga pengguna dapat melihat blog pada Handphone atau Gadget mereka dengan 

design yang tersesuaikan 

 

6. DotNetNuke Skin 

DotNetNuke adalah sebuah aplikasi web portal yang memungkinkan Anda untuk membuat satu 

atau lebih portal secara dinamis dan interaktif, berbasis database, dengan sangat mudah. 

DotNetNuke dibangun dengan menggunakan bahasa Visual Basic .NET, berbasis database 

SQL Server, dan platform web menggunakan ASP.NET. Kemampuan DotNetNuke dapat 

diperluas dengan cara membuat sendiri modul-modul yang kemudian diintegrasikan pada 

DotNetNuke. Modul-modul ini dapat dibangun dengan menggunakan bahasa apa saja yang 

mendukung .NET seperti Visual C#, Visual J#, atau Visual Basic .NET, atau yang lainnya. 

Meski DotNetNuke menggunakan database SQL Server, ada pihak ketiga di luar sana yang 

membuat DotNetNuke pada versi database MySql dan Microsoft Access. Visi dari DotNetNuke 

adalah membuat sebuah portal / CMS yang bersifat modular dimana ia dapat meningkatkan 

partisipasi manusia dalam berinteraksi dan dalam berbagi pengetahuan. 

DotNetNuke mengeluarkan 3 (tiga) jenis versi installer sebagai berikut : 

- Versi Install, yakni versi dimana Anda hanya tinggal menjalankan saja. Versi ini 

merupakan sebuah file zip tunggal dan tidak berisi seluruh kode sumber DotNetNuke. 

Beberapa file yang disertakan di dalamnya memang menyertakan kode sumbernya untuk 

memudahkan Anda melakukan penambahan dan modifikasi di level yang lebih rendah. 

- Versi Source, yakni versi dimana Anda harus melakukan kompilasi ulang terlebih dahulu 

untuk dapat menjalankannya. Versi ini masih mentah dan berisi semua kode sumber 

DotNetNuke yang dapat Anda lihat dan pelajari. Memungkinkan Anda untuk melakukan 

penambahan dan modifikasi di level yang lebih tinggi. 

- Versi Starter Kit, yakni versi yang terintegrasi dengan Visual Studio dalam bentuk project 

template. Versi ini sama dengan versi Install dengan perbedaan bahwa ia masuk dalam list 

template project di dalam Visual Studio. Jadi, saat Anda ingin membuat project baru dari 
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Visual Studio maka Anda akan menemukan pilihan template bernama DotNetNuke Web 

Application Project. 

 

7. Weebly 

Weebly adalah suatu situs web dan blog gratis yang sangat mudah untuk digunakan oleh 

siapa saja (Pemula maupun Profesional). Weebly sangat cocok bagi mereka yang bergerak 

dalam bidang Pendidikan, Kesehatan, Fotografi, Salon dan kecantikan, Pecinta Binatang, 

Penggemar Otomotif, Musisi, Toko Online, blogger dan lain-lain, dengan menggunakan 

Weebly anda tidak memerlukan pengetahuan tentang HTML, PHP, JavaScript, CSS 

ataupun MySQL, untuk mendesain halaman website anda hanya cukup men-drag and drop 

elemen-elemen yang telah disediakan, kemudian anda mengisi kontennya sesuai 

kebutuhan. Didalam weebly anda bisa leluasa menggunakan elemen – elemen yang bisa 

anda gunakan dalam menciptakan web yang powerfull baik untuk Ecommerce, Gallery 

Foto, Peta/Google Map, membuat Quiz, Pooling/Jajak pendapat, Audio dan Video dan 

lain-lain, anda bisa melihat semua contoh-contoh penggunaan elemen yang ada di weebly 

di website ini. 

 

8. Moodle 

Moodle adalah salah satu CMS yang mengkhususkan diri untuk pembelajaran jarak jauh 

(eLearning), moodle lumayan mempunyai nama didunia CMS untuk elearning.  
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Kata Moodle adalah singkatan dari Modular Object-Oriented Dynamic Learning 

Environment. Moodle sebagai eLeaning CMS atau sering juga disebut Learning 

Management Systems (LMS) atau Virtual Learning Environments (VLE) sebuah aplikasi 

yang dibuat untuk membantu pelaksanaan belajar secara virtual. 

 

Selain Moodle di dunia LMS dikenal juga Atutor yang akan coba kita pelajari juga diblog 

ini. keduanya merupakan LMS yang opensouce, dibawah GNU publlic.selain itu Moodle 

juga mendapat support dari Moodle langsung 

 

Moodle dapat diintalls dengan mudah, asalkan di komputer sudah berjalan PHP dan 

MySql. Karena dikembangkan menggunakan PHP dan MySQL maka Moodle bisa jalan 

lintas platform, artinya anda bisa intalls Moodle di Windows, Linux, Mac, BSD dan lain-

lainya. 

 

Aplikasi Moodle dikembangkan pertama kali oleh Martin Dougiamas pada Agustus 2002 

dengan Moodle Versi 1.0. Saat ini Moodle bisa dipakai oleh siapa saja secara Open Source. 

Sistim yang dibutuhkan agar aplikasi Moodle ini dapat berjalan dengan baik adalah sebagai 

berikut: 

- Apache Web Server 

- PHP 

- Database MySQL atau PostgreSQL 

Dengan menggunakan Moodle kita dapat membangun sistim dengan konsep E-Learning 

(pembelajaran secara elektronik) ataupun Distance Learning (Pembelajaran Jarak Jauh). 

Dengan konsep ini sistim belajar mengajar akan tidak terbatas ruang dan waktu. Seorang 

dosen/guru/pengajar dapat memberikan materi kuliah dari mana saja. Begitu juga seorang 

mahasiswa/siswa dapat mengikuti kuliah dari mana saja. 

Bahkan proses kegiatan test ataupun kuis dapat dilakukan dengan jarak jauh. Seorang 

dosen/guru/pengajar dapat membuat materi soal ujian secara online dengan sangat mudah. 

Sekaligus juga proses ujian atau kuis tersebut dapat dilakukan secara online sehingga tidak 

membutuhkan kehadiran peserta ujian dalam suatu tempat. Peserta ujian dapat mengikuti 
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ujian di rumah, kantor, warnet bahkan di saat perjalanan dengan membawa laptop dan 

mendukung koneksi internet. 

 

Berbagai bentuk materi pembelajaran dapat dimasukkan dalam aplikasi Moodle ini. 

Berbagai sumber (resource) dapat ditempelkan sebagai materi pembelajaran. Nasakah 

tulisan yang ditulis dari aplikasi pengolah kata Microsoft Word, materi presentasi yang 

berasal dari Microsoft Power Point, Animasi Flash dan bahkan materi dalam format audio 

dan video dapat ditempelkan sebagai materi pembelajaran. 

 

Berikut ini beberapa aktivitas pembelajaran yang didukung oleh Moodle adalah sebagai 

berikut: 

Assignment : Fasilitas ini digunakan untuk memberikan penugasan kepada peserta 

pembelajaran secara online. Peserta pembelajaran dapat mengakses materi tugas dan 

mengumpulkan hasil tugas mereka dengan mengirimkan file hasil pekerjaan mereka. 

Chat : Fasilitas ini digunakan untuk melakukan proses chatting (percakapan online). 

Antara pengajar dan peserta pembelajaran dapat melakukan dialog teks secara online. 

Forum : Sebuah forum diskusi secara online dapat diciptakan dalam membahas suatu 

materi pembelajaran. Antara pengajar dan peserta pembelajaran dapat membahas topik-

topik belajar dalam suatu forum diskusi. 

Kuis : Dengan fasilitas ini memungkinkan untuk dilakukan ujian ataupun test secara 

online. 

Survey : Fasilitas ini digunakan untuk melakukan jajak pendapat. 

Moodle juga menyediakan kemudahan untuk mengganti model tampilan (themes) website 

e-learning dengan menggunakan teknik template. Beberapa model themes yang menarik 

telah disediakan oleh Moodle. Selain itu tidak menutup kemungkinan bagi kita untuk 

merancang dan membuat bentuk tampilan (themes) sendiri. 

Bahasa : Beberapa pilihan bahasa juga telah disediakan oleh aplikasi Moodle. Dukungan 

terhadap bahasa tertentu ini terus berkembang dan dapat di dapatkan dengan cara men-

download-nya dari website Moodle. Saat ini penggunaan bahasa Indonesia juga telah 

didukung oleh Moodle. Sehingga website pembelajaran yang kita buat tersebut tampil 

dalam bahasa Indonesia. 



18 
 

Moodle mendukung pendistribusian paket pembelajaran dalam format SCORM (Shareble 

Content Object Reference Model). SCORM adalah standard pendistribusian paket 

pembelajaran elektronik yang dapat digunakan untuk menampung berbagai macam format 

materi pembelajaran, baik dalam bentuk teks, animasi, audio dan video. Dengan 

menggunakan format SCORM maka materi pembelajaran dapat digunakan dimana saja 

pada aplikasi e-learning lain yang mendukung SCORM. Saat ini telah banyak aplikasi e-

learning yang mendukung format SCORM ini. Dengan demikian maka antar lembaga 

pendidikan, sekolah ataupun kampus dapat saling berganti materi e-learning untuk saling 

mendukung materi pembelajaran elektronik ini. Dosen atau pengajar cukup membuat 

sebuah materi e-learning dan menyimpannya dalam file dengan format SCORM dan 

memberikan materi pembelajaran tersebut dimanapun dosen atau pengajar itu bertugas. 

Demikianlah ulasan dan pembahasan singkat tentang penggunaan Moodle dalam 

mendukung kegiatan pembelajaran elektronik (e-learning) atau pembelajaran jarak jauh 

(distance learning). Semoga bermanfaat bagi Anda semua dan tentunya dapat membuka 

wawasan kita tentang konsep e-learning dan berbagai macam kemudahannya. 

 

9. Concrete5 

 

Concrete5 adalah Content Management System atau CMS dengan lisensi open source. 

Dengan tampilan yang simpel dan sederhana yang diberikan, Concrete5 akan 

mempermudah Anda untuk membuat sebuah website profesional. 
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Bab 3 

Design Template Website 
 

 

Template Website merupakan salah satu bahan dokumen atau file yang sangat di butuhkan 

dalam hal pembuatan website. Pada dasarnya, seorang webmaster perlu mengetahui pengertian 

template website itu sendiri sebelum membangun sebuah website. 

 

Template atau Theme merupakan dokumen atau file yang berisikan model-model tambahan 

yang akan muncul pada saat proses pembuatan dokumen lain. Sedangkan Website merupakan 

situs atau halaman di Internet yang menyediakan informasi dan tertanam pada World Wide 

Web (www). 

Dari pengertian 2 kata diatas, Pengertian Template Website itu adalah sebuah desain tampilan 

halaman  dengan berisikan dokumen file model-model tambahan yang dikodekan dalam bahasa 

program dan siap pakai. 

Template merupakan salah satu identitas anda. Kita tidak dapat memilih Template yang 

mengikuti taste kita sendiri, apabila web yang anda tujukan untuk visitor dengan kalangan 

tertentu. Akan tetapi pemilihan template bebas dapat anda lakukan secara sepihak apabila itu 

tidak diperuntukan untuk moneytise bahkan mungkin dikhususkan untuk anda sendiri. 

Berikut beberapa Tips dalam memilih Template untuk website ataupun Blog anda. 

- Tujuan atau arah website 

Sebelum merancang sebuah web alangkah baiknya anda memikirkan untuk mencari template 

yang sesuai dengan isi dari tujuan web anda. Contohnya Anda membuat web tentang 

pembelajaran tetapi anda memilih template yang berwarna pink dan background dihiasi bunga, 

hal ini tidak singkron. Dan apabila anda merniat untuk bisnis online atau iklan seperti google 

adsense maka persiapkanlah template yang tersedia kolom letak untuk menempatkan iklan 

tersebut. 

- Pilih Template yang menarik 

Carilah template yang di rasa menarik bagi anda maupun pengunjung. Di situs banyak sekali 

tersedia contoh template yang menarik baik berbayar maupun yang gratis. Luangkan waktu 

beberapa hari untuk mencari template yang memang yakin bagi anda itu bagus. Jangan sampai 
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di suatu ketika anda menyesal anda menemukan template yang lebih  baik dari yang anda 

gunakan sekarang yang pada akhirnya memilih untuk mengganti template yang telah anda 

pasang sebelumnya. 

- Template yang ringan 

Salah satu faktor yang penting lainnya adalah besarnya file template  tersebut. Anda harus 

memperhatikan berat tidaknya proses loading web anda. Visitor akan enggan berkunjung ke 

web anda apabila proses loadingnya terlalu lama. Maka hindarilah hal seperti ini. Banyak faktor 

faktor yang membuat web itu menjadi berat diantaranya: 

• Terlalu banyak gambar ukuran besar 

• Terlalu banyak script atau variasi yang terpasang 

• Ukuran template yang besar 

• Faktor server hosting yang terlalu sibuk atau memang lambat 

Dari hal tersebut kita bisa kita bisa memilih template yang bagus dan cepat proses loadingnya. 

Untuk mengukur kecepatan web beserta komponen yang paling lengkap bisa anda coba di 

websiteoptimization 

 

- SEO Friendly 

SEO adalah kependekan dari Search Engine Optimization, suatu teknik agar website yang kita 

buat mudah ditemukan melalui search engine seperti Google. 

Internet merupakan media yang paling murah, efektif dan cepat dalam menyampaikan 

informasi. Media lain brosur misalnya harus melakukan aktivitas cetak dan kirim secara fisik. 

Untuk media televisi biayanya sangat besar, dan hanya beberapa detik saja.  

Dengan internet kita cukup membayar internet, membuat website, mengupdate isinya. Namun 

meskipun demikan itu tidak berarti apa-apa jika kita website kita tidak dikunjungi orang. Oleh 

karena itu kita harus berusaha supaya web kita dikunjungi orang. Cara yang paling efektif 

mendatangkan pengunjung adalah melalui search engine Google. Inilah yang disebut Search 

Engine Optimization. 

Jenis template yang friendly terhadap search engine atau tidak. Tetapi anda bisa melihat atau 

mencari di situs penyedia dengan memakai keyword seo template. Pada umumnya untuk 

blogspot atau wordpress untuk seo friendly boleh di katakan banyak tersedia baik yang gratis 

mapun yang berbayar, akan  tetapi untuk cms joomla masih terdapat banyak kendala, hal ini 
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juga di dukung oleh server anda, yang artinya tidak semua server mendukung atau support 

dengan SEO Friendly. 

 

Berikut merupakan beberapa alamat link yang menyediakan berbagai macam template Joomla, 

Wordpress, Drupal, CMS Simple dan CMS Made Simple secara gratis. 

 

JOOMLA 

- http://www.joomspirit.com/free-templates.html 

- http://templatejoomla.com/ 

- http://www.siteground.com/joomla-hosting/joomla-templates.htm 

- http://www.joomla24.com/remository.html 

- http://www.template4all.com/joomla/ 

- http://template-for-joomla.com/joomla-templates.html 

- http://joombloger.com/2010/10/syndicate-joomla-template/ 

 

Wordpress 

- http://wordpress.org/extend/themes/ 

- http://wordpresstemplates.name/ 

- http://www.freewpthemes.net/wordpress-themes/ 

- http://freewordpresstemplate.org/ 

- http://freewordpresstemplate.net/ 

- http://wordpressthemesbase.com/ 

- http://www.wordpresstemplates.com/ 

- http://templates.arcsin.se/ 

- http://wptemplates.org/ 

- http://www.free-web-template.org/ 

 

Drupal 

- http://drupal2u.com/ 

- http://drupal.org/project/themes 

- http://freetemplate24.com/drupal/ 
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- http://themebot.com/free-website-templates/drupal-themes 

- http://www.freecmstemplates.com/drupal.php 

- http://freedrupaltheme.com/ 

- http://www.templatemonster.com/free-drupal-themes.php 

- http://drupal-templates.eu/ 

 

CMS Simple 

- http://www.freecmstemplates.com/ 

- http://www.cmsms.pl/ 

- http://www.dotcomwebdesign.com/ 

- http://torsten-behrens.de/ 

- http://www.fluid-webdesign.com/blog/index.php/2008/04/523-free-templates-for-cmsimple/ 

- http://www.cmsimplewebsites.com/ 

- http://www.ge-webdesign.de/cmsimpletemplates/?Template_Auswahl 

- http://www.cmsimple-styles.com/cmsimplestyles/ 

 

CMS Made Simple 

- http://themes.cmsmadesimple.org/ 

- http://www.icms.info/cmsms-templates 

- http://p-ahlqvist.com/freebees/cms-made-simple-templates/cms-made-simple-templates/ 
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Bab 4 

Artisteer 4.0 
 

Salah satu hal yang kita lakukan dalam aktivitas blogging adalah mendesain tampilan dari blog 

kita sebagus  mungkin agar pengunjung merasa nyaman saat berkunjung ke blog kita. 

Diantaranya dengan penempatan navigasi, pemilihan warna , penempatan widget serta pemilihan 

template yang tepat. Kita bisa mendapatkan berbagai template blog secara gratis di internet, 

namun terkadang kita merasa kurang puas karena template tersebut sudah banyak yang 

menggunakan. Namun anda tak perlu khawatir karena kita bisa mendesain template blog sendiri 

dengan menggunakan artisteer, sebuah aplikasi untuk membuat template berbagai platform 

seperti blogger, wordpress, joomla, dotnetnuke, drupal dll. 

Dengan interface yang user friendly kita bisa menggunakannya dengan mudah tanpa harus 

menghafalkan berbagai kode html, javascript maupun CSS. Kita hanya harus mendesain 

bagaimana tampilan yang kita inginkan dan Artisteer akan membuat kode template tersebut 

beserta dengan komponen yang dibutuhkan seperti CSS, Javascript maupun gambar-gambar 

penyusun template blog. 

 

Melalui Mesin pencari kita bisa mencari ratusan template untuk web site kita baik yang bangun 

dengan cms seperti joomla, drupal ataupun yang berbasis blog semisal wordpress atau blogger. 

Tetapi kadang  template yang sudah disediakan untuk kita download tidak benar-benar seperti 

yang kita harapkan seperti terlalu banyak iklan, atau kata-kata yang tidak berhubungan dengan 

web kita. Bagi yang menguasai bahasa pemrograman pembuatan website dan menguasai grafik 

desain seperti photoshop mungkin bukan hal yang susah untuk membuat template sendiri, tetapi 

bagaimana dengan orang yang tidak mengusai keduanya tetapi ingin membuat template yang 

bagus dan sesuai yang diharapkan. Solusinya adalah menggunakan software pembuatan 

template, salah satunya adalah Artisteer designer web otomatis. Saat ini artisteer sudah 

memasuki versi 4 (http://www.artisteer.com/). 
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Gambar 1 : Website Resmi Artisteer 

Artisteer adalah sebuah program pembuat template web secara otomatis secara instan, tampilan 

yang fantastis unik yang bisa di export untuk berbagai web site template, kelebihan lainnya 

adalah MenDesign template yang menarik dan keren hanya dalam waktu beberapa menit Bisa di 

eksport ke joomla, wordpress, blogger dan beberapa produk CMS lainnya Tidak perlu 

penguasaaan teknik pemrograman web maupun design grafik semisal photoshop 

Menyenangakan dan gampang penggunaannya. 

 

Artisteer bisa di download trialnya di website resminya, http://www.artisteer.com untuk crack 

atau sebagainya bisa dicari dengan mudah di mesin pencari. 

Jadi 10 alasan utama kita memakai artisteer sebagai berikut : 

1. Menghasilkan ide-ide desain web keren. 

2. Sesuaikan desain dihasilkan untuk membuat Web tampak hebat dan Blog template. 

3. Buat sempurna benar, divalidasi HTML dan CSS yang sesuai dengan standar Web. 

4. Anda tidak perlu belajar Photoshop, CSS, HTML dan teknologi web lainnya untuk membuat 

desain tampak besar, termasuk gambar dan tombol. 

5. Jika Anda seorang desainer Web, menghasilkan gagasan, prototipe dan Website cepat untuk 

klien Anda dan teman-teman. 

6. Memilih dan menggunakan banyak elemen desain disertakan, dari latar belakang ke obyek 

foto dan tombol. 

http://www.artisteer.com/
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7. Otomatis memecahkan masalah dengan gambar aliasing, browser Web kompatibilitas dan 

rincian lain yang membutuhkan waktu dan pengetahuan. 

8. Pelajari cara membuat HTML profesional dan kode CSS. 

9. Simpan uang di Wordpress Tema dan Web desain template. 

10. Jika Anda tidak punya waktu, mempekerjakan anak-anak Anda untuk membuat besar 

mencari desain web untuk Anda. 
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Bab 5 

Komponen-Komponen Artisteer 

 

 

5.1 Install Artisteer 4.0 

Sebelum membahas lebih detail tentang aplikasi Artisteer alangkah lebih baik kita mulai dari 

awal, yaitu instalasi artisteer. Aplikasi yang diinstal yaitu versi 4.0. Berikut tahapan 

instalasinya : 

 

Gambar 2 : Instalasi Artisteer, Pemilihan bahasa yang akan digunakan. 

 

Pada instalasi Aplikasi Artisteer ini sama dengan versi-versi sebelumnya yaitu diawali 

dengan pemilihan bahasa, biasanya kita pilih English karena itulah bahasa yang termudah di 

nergara kita setelah bahasa Indonesia tentunya. 

Setelah kita pilih bahasa kemudian klik next untuk melanjutkan proses installasi. 
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Gambar 3 : Rekomendasi instalasi 

 

Anda diminta untuk menutup semua aplikasi yang sedang berjalan di windows agar 

mempermudah proses installasi karena Artisteer menggunakan resource yang lumayan besar 

sehingga akan mengganggu jika banyak aplikasi yang masih berjalan. Jika telah menutup 

semua aplikasi yang sedang berjalan kemudian klik next untuk melanjutkan klik back untuk 

ubah bahasa dan cancel untuk membatalkan installasi. Software ini dilindungi undang-

undang untuk itu diwajibkan menggunakan versi resmi atau trialnya. Untuk versi trial 

software ini hanya menyajikan tatacara design dan kemudahan-kemudahan yang ditawarkan, 

kelemahannya kita tidak leluasa untuk ekport hasilnya. 
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Gambar 4 : Term Condition 

Sebaiknya anda membaca term condition ini terlebih dahulu jika akan menginstlasi aplikasi 

karena disana terdapat ketentuan yang harus kita sepakati. 

Jika anda setuju dengan segala ketentuan yang diberikan maka silahkan klik I accept the 

terms of the lisence agreement. Kemudian klik next untuk melanjutkan. 

 

Gambar 5 : Pemilihan folder instalasi 
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Secara default folder artisteer akan ditempatkan pada C:\Program Files\Artisteer 4, kita juga 

bisa memindahkan sesuai dengan keingingan kita. Untungnya untuk semua versi di artisteer 

tidak saling bertabrakan karena akan membentuk folder sendiri-sendiri. Kita juga dapat 

menjalankan aplikasi artisteer berbagai versi secara bersama-sama.  

 

 

Gambar 6 : Shortcut Settings yaitu penempatan shortcut pada desktop 

 

Shortcut digunakan untuk menjalankan aplikasi pada tahapan instalasi ini kita ditawarkan 

pilihan apakah kita akan menempatkan shortcut pada desktop atau pada quick launch 

shortcut. Penulis sarankan untuk klik keduanya untuk mempermudah pada saat pemanggilan 

aplikasi, maksudnya adalah agar mempermudah menjalankan kembali pada saat komputer 

kita matikan. 
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Gambar 7 : Proses instalasi artisteer 

 

Kita tunggu seluruh proses installasi selesai hingga 100%, pada versi 4 ini proses instalasi 

tidak sekaligus menginstall tujuan export dari hasil design, defaultnya hanya untuk 

wordpress, blogger dan design web, untuk template lainnya dapat ditambahkan secara gratis 

setelah proses install selesai. 

 

Gambar 8 : Proses intallasi selesai. 
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Proses installasi selesai dengan sempurna, jika kita akan langsung menjalankannya maka klik 

launch program file maka aplikasi akan langsung terbuka, tetap jika lain waktu maka jangan 

dicentang. 

Jika anda menggunakan versi demo maka hasil yang dibuat dari program aplikasi tidak dapat 

diekspor menjadi template sehingga mau tidak mau kita harus menggunakan aplikasi yang 

resmi. 

Jika anda menggunakan crack maka tinggal mencarinya di mesin pencari dan mereplace file 

artisteer.exe menjadi artisteer.exe yang sudah tervalidasi. Pada proses ini aplikasi artisteer 

tidak sedang dijalankan. 

 

Gambar 9 : Tampilan awal artisteer. 

 

Pada tampilan awal maka kita akan ditawarkan template yang sudah jadi berdasarkan 

kategori dan seluruh template, disamping kanan adalah aplikasi-aplikasi yang telah kita buat. 

Artisteer menghasilkan ektensi file  .artx  dan secara default akan membuat folder pada 

Document dengan nama Artisteer Templates. 

Penyimpanan berbagai versi biasanya tercampur dari versi-versi sebelumnya. Tapi tidak 

masalah jika kita menggunakan versi yang lebih tinggi.  
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Gambar 10 : Template awal jika kita membuat design menggunakan artisteer. 

 

Jika kita tidak memilih template yang ditawarkan dan akan membuka file yang baru maka di 

versi 4 akan menampilkan tampilan awal template seperti pada gambar 10. Dari dasar 

tempale tersebut kita dapat memulai merubah tampilan sesuai dengan yang kita inginkan 

tanpa kita harus mengerti HTML ataupun program-program lainnya. 

Semuanya mudah hanya plug n play semuanya yang Nampak maka akan menjadi template 

kita nantinya. 

 

5.2 Ideas 

adalah saran/ide dari artisteer untuk berbagai desain meliputi warna, font, layout, 

background, sidebar dll, Artisteer menyediakan ide untuk membantu kita mendesign web 

template yang sedang dikerjakan. Jika disara kurang pas maka kita bisa klik terus menerus, 

berikut ini tampilan ideas yang diberikan artisteer 4.0. 

 

Gambar  11 : Idea dari artisteer 

5.2.1 Suggest Design 

Suggest Design adalah ide perancangan template yang diberikan artisteer, kita dapat 

memilih salah satu ide yang kita sukai, suggest design akan memberikan secara global 

perancangan web dari mulai tata letak header, warna, font, gambar, layout dan lain-lain. 
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Kita dapat memberikan perintah Ctrl D atau mengeklik tombol Suggest Design, berikut 

ini tombol yang harus di klik untuk mengganti-ganti design yang kita inginkan. 

 

Gambar 12 : Tombol Suggest Design atau CTRL +D, akan secara otomatis mengubah 

design 

 

5.2.2 Suggest Colors 

Jika kita sudah sesuai dengan layout yang ditawarkan tetapi ingin melihat warna-

warna yang lain kita dapat menggunakan Suggest Colors untuk mengubah-ubah 

warna, berikut ini perubahan-perubahan warna yang diberikan setelah mengeklik 2 

kali suggest Colors. 

 

Gambar 13 : Perubahan warna setelah kita memilih Suggest Colors 

 

5.2.3 Suggest Font 

Setelah kita mengubah-ubah warna dari design yang kita pilih, kita pun dapat 

mengubah jenis font yang kita inginkan pada template kita, font tersebut akan 

disimpan pada file CSS dan font tersebut akan digunakan pada semua isi web kita. 
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Cascading Style Sheet (CSS) merupakan salah satu bahasa pemrograman web  untuk 

mengendalikan beberapa komponen dalam sebuah web sehingga akan lebih 

terstruktur dan seragam. Sama halnya styles dalam aplikasi  pengolahan kata seperti 

Microsoft Word yang dapat mengatur beberapa style, misalnya heading, subbab, 

bodytext, footer, images, dan style lainnya untuk dapat digunakan bersama-sama 

dalam beberapa file. Pada umumnya CSS dipakai untuk memformat tampilan 

halaman web yang dibuat dengan bahasa HTML dan XHTML. CSS dapat 

mengendalikan ukuran gambar, warna body teks, warna tabel, ukuran border, warna 

border, warna hyperlink, warna mouse over, spasi antar paragraf, spasi antar teks, 

margin kiri/kanan/atas/bawah, dan parameter lainnya.CSS adalah bahasa style sheet 

yang digunakan untuk mengatur tampilan dokument. Dengan adanya CSS 

memungkinkan kita untuk menampilkan halaman yang sama dengan format yang 

berbeda. 

 

Gambar 14 : Suggest Font Untuk memilih font yang disarankan oleh artisteer 

 

Font yang diberikan artisteer adalah font standart yang digunakan secara umum oleh 

website yang terkenal, jadi kita tidak akan disarankan untuk menggunakan font-font 

aneh seperti horror dan sejenisnya. 
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5.2.4 Suggest Layout 

Layout adalah proses penataan dan pengaturan teks atau grafik pada halaman. 

Layout meliputi penyusunan , pembagian tempat dalam suatu halaman, pengaturan 

jarak spasi, pengelompokan teks dan grafik, serta penekanan pada bagian tertentu. 

Layout menurut bentuk terdiri dari : 

1. Model Top Index 

Biasanya layout  ini cocok digunakan untuk situs portal. Dengan banyak menu dan 

fasilitas yang ditawarkan, atau menampilkan link yang banyak ke situs lain. 

 

Gambar 15 : Model Top Index 

2. Model Layout Bottom Index 

Biasanya digunakan apabila isi dari halaman banyak berhubungan dengan topik 

tunggal. 

 

Gambar 16 : Model Layout Bottom Index 
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3. Model Layout Left Index 

Layout tipe ini lebih akrab dengan pengunjung karena tampilan menu sama dengan 

sistem informasi. 

 

Gambar 17 : Layout Left Index 

4. Model Layout Right Index 

Kebalikan dari left index, cuma bedanya menu di bagian kanan jarang dipakai 

untuk menu utama. 

 

Gambar 18 : Layout Right Index 

Tetapi ada juga yang suka menempatkan menu disebelah kanan terutama yang base 

islam menunya ada di sebelah kanan. 
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5. Model Layout alternating index 

Biasanya digunakan untuk menampilkan grafik, foto, harga, jumlah, dan lain – lain. 

 

Gambar 19 : Layout Left Index 

 

 

Dengan menggunakan artiteer suggest layout langsung tertata dengan rapi dan kita 

tinggal memilih layout sesuai dengan kebutuhan kita, berikut ini tampilan suggest layout 

pada artisteer : 

 

Gambar 20 : Pelihan menu di Artisteer 
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5.2.5 Suggest Background 

Tampilan webpage akan menjadi daya tarik sendiri untuk dikunjungi. Memang, 

bagaimana pengunjung sampai ke suatu website kemungkinan paling besar adalah 

dengan mengetik kata-kata kunci (keywords) di browser. Kemudian mesin pencari akan 

menampilkan halaman-halaman  hasil pencariannya yang di dalamnya termaktub satu 

(atau lebih) URL yang mengarah ke website tersebut.  

Sumber pengunjung lain dari website tersebut adalah mereka yang terkesan dengan 

tampilan webpage – baik sebagai pengunjung untuk pertamakalinya atau sebagai 

kunjungan ulang. Meskipun kebanyakan kunjungan ulang lebih dipengaruhi oleh isi 

content. Salah satu unsur pembentuk tampilan halaman web yang mengesankan adalah 

Background. Background webpage boleh jadi berupa latar belakang berwarna atau blank 

(kosong atau putih), image tunggal berupa photo besar atau Background Repeat dengan 

pola atau image  berulang seperti gambar di samping. Pengulangan tampilan ini terbagi 

dalam beberapa variasi : Repeat secara horizontal dan vertikal, Repeat secara vertikal, 

Repeat secara horizontal atau No Repeat. 

 

5.2.6 Suggest Header 

 

Gambar 21 : Suggest Header 

Suggest Header digunakan untuk memilih header secara otomatis, Artisteer akan 

memberikan  saran untuk header-header yang sesuai dengan selera kita. Jadi saat kita 

tidak tahu harus bagaimana membuat header kita tinggal klik Suggest Header langsung 

jadi. Header yang baik adalah header yang informative dan tidak terlalu berat saat 

diloading oleh pengguna. Kadang karena kita mahir animasi kita menggunakan header 

yang bermacam-macam, suggest header memberikan saran tentang header yang standart. 
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5.2.7 Styles 

 

 

Gambar 21 : Suggest Style 

User akan diberikan pilihan style general, Corporate, magazine atau blog atau kita dapat 

menggunakan semua style tersebut bersama-sama. 

  

5.3 Colors & Font 

Untuk memilih warna dan font yang digunakan dalam templates, kita akan diberikan 

berbagai warna yang sesuai dengan gradasi, dengan aplikasi ini kita dapat menentukan warna 

tanpa harus belajar ilmu interaksi manusia dan computer. Warna yang disajikan telah sesuai 

dengan komposisi pewarnaan sebuah web.  

 

 

Gambar 22 : Menu Colors & Font 

Jika kita bingung tentang komposisi warna kita bisa pilih Suggest Colors atau kita juga bisa 

memilih color themes agar komposisi warnanya sudah diatur otomatis.  
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5.4 Layout 

Layout pada artisteer adalah penampakan design web secara umum ke pengguna, jadi bagian 

inilah yang selalu dilihat oleh pengguna. Bagus atau tidaknya sebuah web kadang dinilai dari 

tampilan layout dari suatu web. 

 

 

Gambar 23 : Menu layout 

Pada menu Layout didalamnya terdapat perintah Suggest layout, Design Layout, Header, Menu, 

Footer, Sheet width, margin, padding, columns, column width, column style, margin, new blok 

dan widgets. 

Jadi pada saat kita binggung untuk menentukan bagaimana layout tampilan web kita seperti biasa 

andalan kita adalah Suggest Layout, Disana kita akan diberikan alternative design yang sangat 

banyak, kita tinggal memilihnya. Kemudian setelah dipilih kita tinggal sesuaikan dengan 

kebutuhan kita seperti header, menu, footer, margin dan sebagainya. 
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Bab 6 

Membuat Blog 

 

6.1  Membuat Email Gratis 

Untuk membuat blog di www.blogger.com kita harus mempunyai email di google pula, 

layanan email dari google yang gratis adalah gmail dengan mengklik gambar seperti 

dibawah : 

 

Gambar 24 : url www.google.co.id 

Untuk membuat email pertama-tama kita harus masuk ke www.google.co.id kemudian pilih 

gmail.  

 

 

Gambar 25 : Pilihan untuk membuat email baru 

http://www.blogger.com/
http://www.google.co.id/
http://www.google.co.id/
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Gambar 26 : pengisian biodata pengajuan email 

 

Gambar 27 : Konvirmasi pembuatan email melalui HP 

 

Gambar 28 : Hasil verifikasi berhasil 

 

Jika kita telah mengisi semua persyaratan pembuatan email dengan baik maka kita akan 

diminta melakukan verifikasi melalui nomor HP yang diinputkan. Jika berhasil maka akan 

tampak seperti gambar 28. 
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Gambar 29 :  Tahapan pemberitahuan alamat email kita. 

 

 

Gambar 30 : Email kita sudah berhasil dibuat  

Jika email kita sudah berhasil dibuat, setelah kita login maka kita akan mendapatkan 4 email 

untuk keterangan term dan kondisi. 

 

6.2  Membuat Blog Gratis 

 

Gambar 31 : Login ke Blogger dengan email Gmail 
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Gambar 32 : Pemilihan bahasa 

Setelah kita berhasil login, hal pertama yang harus dipilih adalah bahasa karena akan 

menyulitkan membacanya jika bahasa yang ada tidak kita mengerti. Ada banyak pilihan bahasa 

didunia. Jika kita kurang paham bahasa inggris atau bahasa lainya kita bisa memilih bahasa 

Indonesia. 

 

 

Gambar 33 : Membuat blog baru 

Untuk membuat blog baru kita klik menu New Blog atau Blog Baru kemudian lakukan langkah 

selanjutnya. 



45 
 

 

Gambar 34 : Blog baru dengan judul inspiring for excellences 

 

 

Gambar 35 : Menulis berita. 

Terkadang pada saat pencarian berita atau membuat reportase dari suatu kegiatan menjadi sangat 

sulit, karena tidak tahu apa yang harus ditulis dalam berita tersebut. Ada trik sederhana untuk 

penulisan jurnalistik sederhana agar berita yang disajikan dapat dibaca serasa hidup dan 

mengalir. Untuk informasi berita ada beberapa pertanyaan mendasar yang harus ditanyakan pada 

responden yaitu apa, dimana, kapan, siapa, berapa dan bagaimana. 

Berikut ini contoh studi kasus acara “Seminar Nasional Kebudayaan Islam”, dari judul ini akan 

dibuat pertanyaan : 

1. Apakah acara seminar nasional kebudayaan Islam? 

2. Dimana acara tersebut dilaksanakan? 
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3. Kapan acara tersebut dilaksanakan? 

4. Siapa yang menjadi pembicara dalam acara tersebut? 

5. Siapa yang menjadi peserta pada acara tersebut? 

6. Berapa peserta pada acara tersebut? 

7. Bagaimana jalannya acara tersebut? 

8.  Apa hasil dari acara tersebut? 

Dari jawaban pertanyaan tersebut kemudian dirangkai menjadi sebuah narasi kalimat yang 

mengalir sehingga mudah untuk dibaca.  

Hasil setelah dibuat narasi akan menghasilkan tulisan seperti dibawah ini : 

 

Seminar Nasional Kebudayaan Islam 

 

Kebudayaan islam merupakan(1) salah satu hasil budaya bangsa Indonesia yang berkembang 

seiring berjalannya waktu, dengan berdatangannya pedagang Gujarat yang menyebarkan 

agama Islam maka dengan proses itu pula budaya islam mulai berkembang mempengarui 

budaya local. Adakalanya budaya islam bercampur dengan budaya local yang menghasilkan 

gabungan unsur kebudayaan. Untuk mengenalkan budaya islam, IAIN Syekh Nurjati 

mengadakan seminar kebudayaan islam yang diadakan secara nasional. 

 

Seminar nasional bertempat(2) di Gedung ICC IAIN Syekh Nurjati Cirebon dilaksanakan 

pada(3) hari senin tanggal 13 agustus 2012 dari jam 9:00 wib sampai selesai dengan 

pembicara(4) bapak Dr. Abdul dari Semarang dihadiri(5) oleh sekitar 300 peserta yang terdiri 

dari(6) dosen, staf, mahasiswa serta undangan dari berbagai elemen masyarakat yang ingin 

lebih mendalami tentang kebudayaan Islam. 

 

Pelestarian kebudayaan Islam(7) merupakan kewajiban dari seluruh elemen bangsa begitu 

cetus Dr. Abdul menjawab pertanyaan peserta tentang tanggung jawab pelestarian budaya 

Islam. Pengembangan dan Pelestarian nilai-nilai adat budaya dan agama memiliki makna yang 

sangat penting di Cirebon dalam rangka menghadapi kemajuan zaman membawa perubahan 

dapat merusak sendi-sendi agama dan budaya adat istiadat yang berlaku dalam kehidupan 

masyarakat Jawa  Barat umumnya dan IAIN khususnya. Adat merupakan suatu tatanan 

kehidupan yang telah terjadi pada masa masa yang lalu untuk mengatur kehidupan yang 

beretika, sopan dan beradab sesuai dengan tuntunan ajaran agama islam. 

 

Hasil yang diharapkan(8) dari acara seminar nasional kebudayaan islam adalah kita sebagai 

bangsa diharapkan turut serta dalam membudayakan seluruh budaya salah satunya adalah 

budaya islam begitu yang diharapkan panitia seminar. 
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Pada berita diatas jelas seluruh komponen berita disusun berdasarkan pertanyaan yang ada 

sehingga penulis hanya merangkai kata untuk menghasilkan suatu berita yang dapat dinikmati 

oleh seluruh masyarakat. Penggunaan foto untuk lebih menghidupkan berita sebaiknya dilakukan 

dengan foto yang berukuran kecil atau sekitar 300x400 pixel sehingga ringan pada saat loading 

datanya. 

 

 

Gambar 36 : Memilih Template Standart Blogger 

Template bisa dipilih dari blogger dengan banyak ragamnnya, tetapi kadang kita tidak puas 

dengan pilihan-pilihan tersebut dan ingin berkreasi sendiri. Untuk itu akan dibahas bagaimana 

mengganti template blog dengan karya kita sendiri melalui artisteer. 
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6.3  Install Wordpress di Server Sendiri 

Langkah 1 : Tentukan database yang akan dijadikan tempat penyimpanan data, database ini 

akan digunakan bersama oleh semua web yang akan menginduk pada domain yang sama.  

Contoh : dbetunas 

 

Gambar 37 : Membuat database baru di phpmyadmin 

Langkah 2 : Buka browser dan url sesuai dengan penempatan foldernya contoh : 

http://localhost/etunas/university/ maka akan menampilkan tampilan sebagai berikut : 

 

Gambar 38 : Memulai installasi wordpress 

Jika menggunakan linux maka wp-config.php diubah secara manual karena hak akses yang 

diprotek, tapi jika kita install di windows maka langsung mengikuti langkah instalasi. 

 

 

 

http://localhost/etunas/university/
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Langkah 3 : klik Create a Configuration File sehingga akan menampilkan tampilan sebagai 

berikut: 

 

Gambar 39 : informasi yang dibutuhkan sebelum installasi wordpress 

Pada saat install wordpress ada informasi yang dibutuhkan sebelum melanjutkan ke tahap 

selanjutnya yaitu database name, database username, database password, database host, table 

prefix 

 

Langkah 4 : klik Let’s go! Kemudian akan menampilkan tampilan sebagai berikut : 

 

Gambar 40 : Form inputan untuk config database. 
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Langkah 5 : Isilah text box dalam form tersebut dengan isian sebagai berikut : 

Content Data keterangan 

Database Name dbetunas Nama database untuk penyimpanan data 

Username root User database 

Password 123456 Password untuk masuk ke database 

Database Host localhost Host, jika secara online maka diisi nama domain 

Table Prefix university_ Table untuk membedakan dengan instalasi lainnya. 

 

Langkah 6 :  

 

Gambar 41 : Setting general wordpress anda 

Langkah 7 : 

 

Gambar 42 : Login ke dashboard 
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Langkah 8 : 

 

Gambar 43 : Dashboard Wordpress 

 

Pada tahap ini proses instalasi telah selesai, silahkan mulai posting berita, menambah page, 

menambah media. Menambah link, menambah page serta menambah widget memalui 

dashboard ini 
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Bab 7 

Setting Web Template Artisteer pada Blogger 

 

Hosting Images 

Blogger tidak mendukung gambar langsung ke rekening Blogspot, sehingga Anda 

akan perlu memilih salah satu metode yang tersedia di Artisteer untuk hosting 

gambar template eksternal. Artisteer menyediakan tiga pilihan gambar yang dapat 

digunakan tergantung pada keandalan dan persyaratan kinerja hosting yang: 

 

1. Album Web Picasa  

Layanan ini digunakan secara default dan cocok dalam kebanyakan kasus 

sebagai Picasa menggunakan akun Google yang sama yang digunakan untuk 

Blogger dan tidak memerlukan pendaftaran tambahan atau konfigurasi.  

Untuk mengatur pilihan hosting menavigasi silakan File -> Export -> 

Options -> Image Hosting.  

 

Gambar 44 : upload gambar ke picasa 

CATATAN: Picasa tidak mendukung gambar besar yang sedang diakses dari 

domain kustom, sehingga ketika hosting blog Anda di domain kustom (com 

misalnya www <yourname>..) Artisteer akan bukannya meng-upload gambar 

yang lebih besar untuk layanan hosting gambar ImageShack gratis. Ini kadang-

kadang dapat menyebabkan kinerja lambat, sehingga pemilik domain kustom 

dapat mempertimbangkan memilih gambar Pilihan di bawah hosting lainnya.  
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2. ImageShack  

ImageShack adalah sebuah alternatif untuk Picasa dan menawarkan layanan 

gratis yang tidak memerlukan pendaftaran pengguna untuk meng-upload 

gambar. Namun demikian, Anda harus terdaftar untuk menggunakan gambar 

Anda host. Artisteer mendukung kedua layanan gratis dan account ImageShack 

dibayar. Masukkan informasi login Anda di Artisteer untuk menggunakan 

ImageShack hosting.  

 

Gambar 45 : Upload gambar ke Image shack 

3. FTP  

Anda dapat memilih untuk meng-upload gambar ke server FTP dengan 

memberikan informasi account FTP, FTP folder di mana Anda ingin gambar 

yang akan disimpan, dan URL yang sesuai dengan folder FTP tertentu.  

 

Gambar 46 : upload gambar ke server sendiri 
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Anda juga dapat menggunakan layanan lain untuk host gambar Anda. Dalam kasus seperti 

itu Anda pilih untuk ekspor (bukan mempublikasikan) template Anda dalam format 

Blogger dan terpisah upload gambar ke tujuan hosting Anda. Perlu diingat bahwa baik 

ImageShack atau Picasa memungkinkan untuk mempublikasikan. File swf. Menggunakan 

Header Flash akan membutuhkan beberapa layanan hosting lain untuk mengirim 

gambar. Untuk ini pilih "Server FTP" sebagai layanan hosting di Artisteer Ekspor Pilihan. 

Mengekspor dan Instalasi Blogger Template 

Dalam beberapa kasus, Anda mungkin memilih untuk tidak mempublikasikan template 

Blogger Anda, tetapi ekspor dan secara manual meng-uploadnya. 

Untuk mengekspor desain Blogger: 

1. Arahkan Ekspor -> Blogger Template. 

 

Gambar 47 : Export template artisteer ke blogger 

2. Dalam dialog Ekspor masukkan nama folder dan path ke template diekspor, periksa 

kotak yang sesuai untuk mengekspor template sebagai arsip ZIP dan / atau termasuk 

proyek ArtX. 

3. Pilih lokasi untuk gambar diekspor, mengkonfigurasi Sumber Menu dan opsi lainnya 

dengan mengklik "Options". 
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4. Klik tombol "Ekspor" tombol. 

 

Untuk menginstal template Blogger: 

1. Buka file main.xml diekspor dan memodifikasi jalur gambar untuk mencerminkan 

lokasi Anda telah memilih untuk menempatkan file gambar. 

2. Login ke Dashboard Blogger Anda. 

3. Navigasi Template -> Edit HTML dan paste kode dari main.xml. 

4. Konfirmasi dan Simpan. 

Membuat Horizontal Menu 

Sebelum menerbitkan / mengekspor template terbuka Artisteer Pilihan Ekspor (File -> 

Export -> Options -> Blogger) dan menentukan Sumber Horizontal Menu. Default 

horisontal sumber menu akan Pages, tetapi Anda juga dapat memilih "Custom" jika Anda 

ingin menggunakan link kustom.  

 

Gambar 48 : Export Option 

 

Untuk mengedit menu di Blogger: 
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1. Login ke Dashboard Blogger Anda. 

2. Pergi ke Layout-> Halaman -> Edit. Ini akan membawa Anda ke Konfigurasi 

Halaman Daftar.  

 

Gambar 49 : Configure Page List 

Jika Anda membuat kustom Top Menu bukannya Pages Anda akan melihat 

Top Menu bar.Pilih Edit dan menambahkan link item menu dalam Links 

Konfigurasi Daftar.  

 

Gambar 50 : Configure Link List 
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3. Klik "Tambah Link" untuk menambahkan link. 

4. Jika Anda membutuhkan menu multi-level silahkan masukkan "-" (dasbor) 

sebelum nama subitem, misalnya: "-Submenu Item".  

Harap dicatat bahwa item Submenu harus ditempatkan di bawah menu item.The 

menu halaman-sumber orangtua hanya dapat memiliki satu tingkat dari item menu. 

5. Klik Simpan. 

Catatan: 

 Jika Anda tidak ingin menggunakan menu silakan pilih tata letak di Artisteer tanpa 

menu. 

 "Home" item ditambahkan ketika "Tampilkan home item" pilihan di Options Ekspor 

Artisteer dialog diatur ke Ya.  

 

Gambar 51 : Untuk menampilkan home 

Bekerja dengan Menu Vertikal 

Dalam Pilihan Ekspor Anda dapat memilih Menu Vertikal sumber - Arsip, Halaman atau 

Custom Menu Vertikal. Pergi silahkan ke File -> Export -> Options -> Blogger. 
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Gambar 52 : vertical menu 

Untuk mengedit Menu Vertikal: 

1. Login ke Dashboard Blogger Anda dan pilih "Layout". 

2. Cari Wilayah Menu Vertikal dan pilih "Edit". Vertikal Wilayah Menu akan diberi nama 

"Artikel", "Link" atau "Arsip" tergantung pada Menu Vertikal Sumber dipilih. 

3. Menambahkan menu link item dalam Links Konfigurasi Daftar. 

4. Jika Anda membutuhkan menu multi-level silahkan masukkan "-" (dasbor) sebelum 

nama subitem, misalnya: "-Submenu Item". Tolong, pastikan untuk menempatkan item 

Submenu di bawah item menu induk.  

Catatan: Menu halaman-sumber hanya dapat memiliki satu tingkat dari item menu.  

Subitems akan muncul di website setelah mengklik item induk. Untuk mengubah 

pengaturan ini, silahkan buka proyek Artisteer Anda dan arahkan Menu Vertikal -> 

Submenu -> Levels -> misalnya Semua Terbuka. Setelah itu kembali mempublikasikan 

template Anda dan ulangi langkah-langkah yang dijelaskan di atas.  
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Gambar 53 : Publikasi Template 

5. Klik Simpan. 

Menampilkan Navbar Blogger 

The "Tampilkan Blogger Navbar" pilihan memungkinkan Anda untuk menyembunyikan / 

menampilkan bar navigasi Blogger di bagian atas halaman Anda. Untuk mengatur opsi ini 

pergi silakan ke File -> Export -> Options -> Blogger.  

 

Gambar 54 : menampilkan navbar blogger 
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Pastikan bahwa Anda tidak melanggar Persyaratan Layanan Blogger jika Anda 

memutuskan untuk menghapus Navbar. 

Menambahkan Gadgets untuk header 

Artisteer 4.0 template dipublikasikan atau diekspor ke gadget dukungan Blogger di 

Header. Gaya dan posisi gadget dapat disesuaikan dengan kode CSS. Silakan ikuti 

langkah-langkah di bawah ini: 

1. Drag dan drop gadget di atas area header. 

2. Klik Edit Gadget dan copy id gadget, misalnya CustomSearch1. Id ini diperlukan 

untuk posisi gadget dengan CSS. 

 

Gambar 55 : Edit Gadget 

 

3. Pilih Edit HTML dan menyisipkan kode CSS kustom setelah / * Mulai Tambahan 

CSS Styles * / di jendela kode. Gunakan CTRL + F untuk pencarian cepat: 

 # CustomSearch1 { 

       top: 20px; 

       kiri: 50%; 

 } 
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Bab 8 

Setting Web Template Artisteer pada Joomla 

 

Membuat Template Joomla dengan Artisteer 

 

Dengan Artisteer Anda langsung dapat merancang sendiri template Joomla yang unik 

Anda tanpa keterampilan teknis atau belajar Dreamweaver, Photoshop, HTML atau 

CSS. Artisteer itu "Ide" fitur otomatis menghasilkan dan mengusulkan desain template 

baru dan unik untuk Anda, yang kemudian dapat menyesuaikan dan menyelesaikan sesuai 

dengan keinginan Anda. Berikut adalah cara untuk membuat dan menerapkan besar 

mencari Joomla ™ template hanya dalam beberapa menit dengan menggunakan Generator 

Template joomla nya Artisteer: 

1. Mulai Artisteer dan klik "Suggest Design" tombol beberapa kali, sampai Anda melihat 

Joomla ™ ide template yang anda sukai!: 

 

 

Gambar 56 : memilih design template 
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2. Sesuaikan elemen desain seperti tata letak, latar belakang, header, font, dll  

 

Gambar 57 : Memilih tataletak 

3. Ekspor template Anda ke folder pada komputer Anda dan zip file.  

 

Gambar 58 : Export ke folder 
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4. Di Artisteer 4 Anda dapat mengekspor konten ke dalam Joomla! ™ template 

juga. Untuk melakukan ini, mengaktifkan "Sertakan Konten" sebelum mengekspor 

template.  

 

Gambar 59 : Menyertakan content 

5. Unggah Joomla baru dibuat ™ Template ke Website Anda melalui Joomla ™ 

Administrasi -!> Extensions -> Extension Manager.  

 

Gambar 60 : Upload template joomla 
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Instalasi Joomla Template 

Untuk menginstal template yang diekspor dan zip melalui panel administrasi Joomla di 

Joomla 2.5 silakan lakukan langkah berikut: 

1. Pergi ke Joomla Administrator (www.your-site.com/administrator) -> Extensions -> 

Extension Manager 

2. Dalam "Extension Manager" memilih pilihan pertama "Paket Upload File" 

3. Klik tombol "Pilih ..." tombol untuk memilih file zip dari komputer Anda 

4. Klik "Unggah & Install" tombol 

5. Pergi ke Extensions -> Template Manager 

6. Cari template dalam daftar dan menempatkan sebuah bintang sebelahnya 

7. Klik "Make default" tombol. 

 

 

 

Gambar 61 : Upload file template 
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CATATAN: Jika nama template yang Anda ingin menginstal sudah ada, Anda harus 

mengubah nama atau menghapus template yang ada sebelum menginstal template baru 

dengan nama yang sama.Prosedur seperti ini khas untuk Joomla. Sebuah template lama 

tidak dapat diganti secara otomatis dengan template baru dengan nama yang sama.  

 

Sebenarnya, banyak server menggunakan batas default 2 MB pada ukuran file 

maksimum. Jika hal ini terjadi dengan server Anda, beberapa file template dianggap terlalu 

besar dan tidak dapat di-upload dengan menggunakan "Upload & 

Install" tombol. Kemudian untuk menginstal template ikuti langkah-langkah di bawah ini: 

Upload file zip. Anda ke folder sementara pada server Anda (misalnya melalui FTP). 

1. Unzip paket template Anda. 

2. Login ke Administrasi Joomla Anda dan pilih Extensions -> Extension Manager -> 

Install. 

3. Di bawah "Install dari Direktori" pilihan masukkan path lengkap ke folder pada server 

tempat file membuka ritsleting Anda berada. 

4. Klik tombol "Install". 

 

 

Gambar 62 : Install template 
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Atau Anda dapat menggunakan "Discover" tab untuk menginstal template yang belum 

melalui proses instalasi normal: 

1. Unzip template paket ke folder di komputer Anda. 

2. Buka direktori instalasi Joomla Anda (misalnya menggunakan FTP File Manager). 

3. Pergi ke direktori / template. 

4. Upload folder template (dengan file diekstrak) ke / direktori dari template pada server 

Anda. 

5. Login ke Joomla Administrasi dan menavigasi Ekstensi -> Extension Manager -> 

Discover. 

6. Klik tombol "Discover" tombol untuk membiarkan Joomla menemukan folder template 

yang diunggah secara manual. 

7. Centang kotak di sebelah template, yang telah muncul dalam daftar. 

8. Klik tombol "Install". 

 

Setelah instalasi dengan salah satu cara menunjukkan Anda dapat mengaktifkan template 

seperti ini: 

1. Login ke Administrasi Joomla Anda dan pilih Extensions -> Template Manager. 

2. Pilih template baru di-upload dari daftar template yang tersedia untuk situs Anda dan 

menempatkan bintang sebelahnya. 

3. Klik "Make default" tombol untuk mengaktifkan template Anda. 

 

Jika Anda ingin mengimpor konten, jangan lupa untuk mengaktifkan "Sertakan 

Konten" sebelum mengekspor template dari Artisteer. Untuk menginstal konten diimpor 

dari Artisteer silakan lakukan hal berikut: 

1. Pergi ke Extensions -> Template Manager, dan buka template Anda 

2. Klik "Impor Konten dari Template" di bawah Pilihan Dasar 
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Gambar 63 : Form Import Content from template 

 

3. Klik "Impor" tombol. 

 

 

Gambar 64 : Import Content from template 

Untuk informasi lebih lanjut silahkan 

kunjungi http://docs.joomla.org/How_to_install_templates  

 

Tata letak Joomla  

Posisi modul Joomla adalah penampung dalam sebuah template. Mereka mengidentifikasi 

posisi dalam template mana output dari modul ditugaskan untuk posisi tertentu akan 

ditampilkan.  

 

 

http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://docs.joomla.org/How_to_install_templates&usg=ALkJrhi5AJb8o4jo9CaIWYVCJnfWZRH0mg
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Gambar 65 : Tata Letak Joomla 
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Dalam Artisteer 4 untuk Joomla 1,6-2,5 template Anda dapat memilih untuk menggunakan 

salah satu posisi berikut pilihan penamaan:  

 

 "Posisi-1, posisi-2 ..." untuk Joomla baru 1,6-2,5 posisi penamaan seperti di default 

Beez2 Template 

 "Kiri, kanan, atas, bawah" untuk Joomla 1.5-seperti penamaan posisi (untuk tujuan 

kompatibilitas) 

 

 

 

Gambar 65 : Export Template Joomla 

 

Jika Anda ingin meng-upgrade situs web yang ada dari Joomla 1.5 ke Joomla 1.6, 1.7, 2.5 

Anda dapat memilih "kanan, kiri, atas, bawah" jenis penamaan, yang akan kompatibel 

dengan versi Joomla terbaru sehingga membebaskan Anda dari berulang penyesuaian 

blok.  

 



70 
 

Menambahkan Modul untuk header 

Dalam Artisteer 4.0 Anda dapat menambahkan modul untuk Header dan gaya / posisi 

mereka dengan kode CSS. Silahkan ikuti langkah-langkah berikut: 

1. Menambahkan modul untuk Header dengan menetapkan ke posisi-30 (atau kop) di 

Manager Modul. 

2. Buka Pilihan Lanjutan dan mengatur akhiran kelas modul untuk "my-modul-1" (spasi 

sebelum saya-module-1 diperlukan). 

3. Tambahkan kode CSS yang mirip dengan file template.css (Template Manager -> 

Template -> [template Anda] -> Edit CSS / CSS template): 

4.   Art-header>.. Saya-modul-1 { 

5.        top: 20px; 

6.        kiri: 50%; 

7.      } 

 

 

Headline dan Teks Slogan 

Dimulai dengan Artisteer 3.1 Headline dan teks Slogan di Artisteer -> Header -> Judul 

menjadi teks boneka, yang tidak akan ditampilkan dalam template Joomla diinstal. The 

Headline dan teks Slogan di Artisteer melayani untuk keperluan desain saja. Anda dapat 

mengisi kolom teks dan melihat hasil sebelum mengekspor template. Untuk menambahkan 

sebenarnya Headline dan konten slogan untuk log in ke website Anda Joomla 

Administrasi, pilih Template Manager> nama Template> Dasar Pilihan> Headline dan 

Slogan bidang dan mengisi konten. 

Memanfaatkan Menu 

Menerapkan gaya Artisteer ke menu Anda 

Silakan gunakan langkah-langkah berikut untuk memanfaatkan gaya menu yang dirancang 

dengan Artisteer: 
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1. Pergi ke Joomla Administrator (www.your-site.com/administrator) -> Extensions -> 

Module Manager 

2. Buka menu yang ada atau membuat yang baru dan tempat ke dalam "user3" ("posisi-1") 

posisi 

CATATAN: posisi "user3" hanya dapat berisi satu menu, atau tidak ada.  

 

Untuk informasi lebih lanjut silahkan kunjungi http://docs.joomla.org/Screen.modules.15 

Membuat Multilevel menu 

Berikut adalah langkah-langkah yang harus Anda ikuti untuk membuat menu bertingkat di 

Joomla Website Anda: 

1. Aktifkan beberapa tingkat menu di Artisteer-> Menu -> Submenu -> Levels -> 

Multilevel. 

2. Pergi ke Administrasi Joomla (www.your-site.com/administrator) dan memungkinkan 

berbagai tingkat dalam modul menu (Extentions -> Module Manager v klik untuk 

mengedit menu (misalnya Top Menu) -> Dasar Options -> "Tampilkan sub-menu 

Produk "). 

3. Pastikan bahwa Anda memiliki item menu di tingkat bawah didefinisikan dalam 

Joomla. 

Membuat Menu Vertikal 

Dimulai dengan Artisteer 2.4 Anda dapat menggunakan seni-vmenu Modul Kelas Suffix 

untuk menerapkan gaya Artisteer menu vertikal untuk modul menu Anda.  

Untuk melakukan hal ini, ikuti langkah-langkah berikut:  

 

1. Login ke Administrasi Joomla dan pergi ke Extensions -> Module Manager.  

Pilih modul yang ingin Anda edit. 

2. Buka Pilihan Lanjutan dan menentukan akhiran seni vmenu. 

http://docs.joomla.org/Screen.modules.15
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3. Perlu diingat bahwa Anda harus menonaktifkan caching jika Anda membuat menu 

vertikal klik-terbuka  

 

 

Gambar 66 : Membuat menu 

 

 

Catatan: Jika Anda mengganti default "seni" awalan di Artisteer (Ekspor Pilihan) dengan 

awalan misalnya kustom "andrew-", Anda juga perlu menambahkan prefiks kustom di 

Joomla (Modul lapangan Suffix Class) untuk menerapkan menu vertikal gaya.  

 

 

 

Gambar 67 : menerapkan menu gaya vertikal 
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Untuk membuat menu vertikal dengan sub-item:  

1. Aktifkan Beberapa tingkat menu di Artisteer> Vertikal tab Menu -> Submenu -> 

Levels.Pastikan bahwa sampel subitem Vertikal bekerja untuk Anda dalam template 

dulu dalam Artisteer. 

2. Membuat menu dengan item sub-menu di Joomla.  

Item sub-menu harus memiliki item induk ditentukan bagi mereka. 

3. Aktifkan beberapa tingkatan dalam modul menu Anda ("Tampilkan sub-menu Items"). 

4. Gunakan art-vmenu Kelas Modul Suffix untuk menerapkan dirancang gaya menu 

vertikal untuk modul menu yang diinginkan 

Perhatikan bahwa subitems tidak akan muncul pada mouse melayang tetapi hanya ketika 

Anda mengklik pada item induk (kecuali untuk menu dengan tingkat terbuka, di mana 

semua sub-item terlihat).  

 

Membuat Vertikal menu dengan Separator 

Separator adalah salah satu dari empat kelompok item menu bersama dengan Internal 

Link, Link Eksternal, dan Alias. Tidak seperti item menu biasa pemisah tidak link ke 

halaman web tertentu, mereka digunakan untuk memilah item menu.  Mulai dari versi 3.0, 

Artisteer template untuk mendukung Joomla Menus Vertikal dengan pemisah.Untuk 

mengaktifkan menu pemisah, silahkan update Artisteer, membuka proyek.  ArtX Anda, re-

ekspor template dan menerapkannya ke Joomla.  Juga, pastikan bahwa tingkat menu 

Vertikal Anda diaktifkan dalam Artisteer sebelum template diekspor (Vertikal Menu -> 

subitem -> Levels -> Perluas Klik / All Open). 

 Untuk membuat custom Menu Vertikal dengan pemisah:  

 

1. Login ke Joomla Administrasi dan membuka menu kustom Anda (Menu-> [kustom 

nama menu]) 
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2. Tekan "Baru" untuk menambahkan item menu dan pilih menu pemisah jenis item, atau 

klik item menu yang ada, Menu Item Type -> Pilih, dan simpan sebagai pemisah teks. 

 

Gambar 68 : Membuat Item Menu 
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3. Buka item, yang akan ditempatkan di dalam separator, dan pilih pemisah sebagai pos 

induknya. 

 

 

Gambar 69 : Menu Item Detail 

 

Membuat Blog Tata Letak 

Mulai dari Artisteer 4 Anda dapat membuat tata letak Anda sendiri dari isi halaman 

blog. Untuk ini, silahkan lakukan hal berikut: 

1. Buka halaman blog yang ingin Anda edit. 

2. Pergi ke Edit -> Isi dan menyesuaikan tata letak dan styling Blog Anda Isi Halaman. 
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Gambar 70 : Styling Blog 

 

3. Aktifkan "Sertakan Konten" dan ekspor template untuk Joomla. 

 

 

Gambar 71 : Export dengan menyertakan kontent 
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4. Dalam Joomla pergi ke Extensions -> Template Manager -> Styles -> [nama template 

Anda] -> dan beralih "Blog Layout Type" untuk "Artisteer". 

 

 

Gambar 72 : Blog Layout Type 

 

 

Catatan: Jika Anda memilih "Default" blog jenis tata letak, tata letak, dibuat dalam 

Joomla, akan diterapkan.  

 

 

Menyesuaikan Footer 

Dimulai dengan Artisteer 4 footer dianggap bagian dari isi website dan dapat diimpor 

bersama dengan konten website lain. Atau, Anda dapat menyesuaikan footer template 

yang melalui administrasi Joomla dengan menempatkan satu atau beberapa modul ke 

dalam "hak cipta" posisi ("posisi 27"). Ini akan mengganti teks standar hak cipta termasuk 

dalam footer Template dengan konten baru yang disediakan oleh modul.  

 

 

Berikut adalah contoh langkah-langkah untuk mengkonfigurasi kustom footer: 
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1. Pergi ke Joomla Administrator (www.your-site.com/administrator) -> Extensions -> 

Module Manager. 

2. Klik "New", pilih "Custom HTML", kemudian pilih "Next". 

3. Dalam Rincian modul tentukan: 

o Tampilkan Judul: Sembunyikan 

o Posisi: hak cipta 

o Kustom Output: (isi footer yang diinginkan) 

4. Simpan perubahan Anda. 

Anda sekarang dapat menggunakan modul yang baru dibuat untuk kustomisasi footer 

lanjut tanpa menggunakan modul tambahan.  

 

Joomla Module Style 

Artisteer 3.0 dan versi yang lebih memungkinkan menggunakan Modul Kustom Сlass 

Akhiran. Jadi, sekarang Anda dapat menggunakan Modul sendiri Kelas Akhiran Anda 

bersama dengan akhiran Artisteer standar, seperti seni-artikel, seni-blok atau seni-

nostyle. Fitur bekerja cukup mirip dengan modul fitur akhiran kelas kustom standar 

bawaan Joomla template kecuali untuk itu membutuhkan sintaks yang tepat.  

 

Untuk mengaktifkan Modul Suffix Kustom, ikuti langkah-langkah di bawah ini:  

 

1. Tentukan kustom Anda. CustomSuffix1 dan. CustomSuffix2 kelas dalam file 

template.css.  

 

2. Masuk ke Administrasi Joomla Anda dan pergi ke Extensions -> Module Manager. Pilih 

modul yang ingin mengedit dan pergi ke Advanced Options. Dalam Modul Kelas Suffix 

jenis parameter kotak akhiran kelas kustom Anda dengan ruang utama (jika Anda 

memasukkan akhiran kustom tanpa ruang terkemuka, kelas css Artisteer tidak akan diubah 

dan akhiran Anda akan diabaikan). 

Pada dasarnya Anda dapat menggunakan: 
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1. [Spasi] CustomSuffix1 CustomSuffix2  

untuk memperoleh blok kelas seperti:  

<div class="art-block CustomSuffix1 CustomSuffix2"> ... </ 

Div> 

 

 

Gambar 73 :  Module Class Suffix 

2. [Salah satu Artisteer akhiran] [spasi] CustomSuffix1 CustomSuffix2  

untuk menghapus blok gaya Artisteer dan menerapkan gaya pos, atau tidak ada gaya ke 

blok. Dalam hal blok kode yang dihasilkan akan terlihat seperti:  

<div class="art-article CustomSuffix1 CustomSuffix2"> ...  

</ Div>  
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Gambar 74 : Art-block customSuffix 

atau <div class="art-nostyle CustomSuffix1 CustomSuffix2"> 

... </ Div> 

3. Kasus terakhir (dengan seni-nostyle akhiran) akan menghapus semua gaya Artisteer 

dan menerapkan Anda CustomSuffix1 CustomSuffix2 kelas / gaya untuk blok.  

 

 

 

Gambar 75 : Art-nostyle customsuffic 
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Bab 9 

Setting Web Template Artisteer pada Wordpress 
 

Artisteer  dapat  membantu  Anda  segera membuat tema WordPressprofesional tanpa 

memiliki bakat artistik atau kemampuan design dengan menggunakan Photoshop, 

Dreamweaver, HTML dan CSS. Artisteer secara otomatis membuat desain tema khas 

bahwa anda dapat menyesuaikan dan menyelesaikan dengan selera Anda.   

 

Berikut ini menjelaskan bagaimana Anda dapat dengan cepat membuat tema besar 

WordPress: 

1. Jalankan Aplikasi Artisteer, kemudian tekan tombol "Suggest Design" tombol 

beberapa kali, sampai Anda melihat tema WordPress ide yang Anda sukai. (Anda juga 

dapat menggunakan "Undo" dan "Redo" tombol untuk mencari ide-ide sebelumnya)  

 

 

Gambar 76 : memilih design template yang sesuai dengan wordpress 
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2. Sesuaikan elemen desain tema Wordpress Anda, termasuk tata letak, latar belakang, 

header, font, dll  

 

Gambar 77 : Memilih tata letak, latar belakang, header, font, dll  

 

3. Ekspor tema WordPress Anda ke folder pada komputer Anda, dan upload file tema ke 

dalam folder tema yang baru dibuat dalam situs WordPress Anda.  

 

Gambar 78 : Export ke Wordpress template  
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4. Dimulai dengan Artisteer 4.0 Anda dapat mengekspor konten ke Wordpress 

tema. Untuk mengaktifkan ini "Sertakan Konten" sebelum mengekspor tema.  Jika 

anda memilih sertakan content maka content yang telah didesign akan disertakan 

dalam template yang kita buat. 

 

Gambar 79 : Export include content 

5. Dalam Administrasi Wordpress (Penampilan -> Tema) memilih tema, kemudian 

mengaktifkannya.  

 

Gambar 80 : Merubah template di wordpress 
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Instalasi Wordpress Themes 

1. Akses server Web Anda menggunakan klien FTP atau alat administrasi server Web. 

2. Buat folder untuk tema tertentu Anda di bawah "wp-content/themes" folder dalam 

instalasi WordPress.  

Sebagai contoh: <WordPressFolder> \ wp-content \ tema \ <YourThemeName>  

3. Menyalin atau meng-upload file tema diekspor dari Artisteer ke folder 

<YourThemeName> baru dibuat. 

4. Login ke panel administrasi WordPress Anda dan pilih Appearance -> Tema. 

5. Pada bagian 'Tema Tersedia' menemukan judul tema Anda dan screenshot, kemudian 

klik link 'Aktifkan' untuk mengaktifkannya. 

Untuk informasi lebih lanjut silahkan lihat dokumentasi WordPress resmi:  

http://codex.wordpress.org/Using_Themes # Adding_New_Themes  

 

Jika Anda menggunakan versi terakhir dari WordPress (2,8-3,4), ada cara alternatif untuk 

menginstal tema baru. Pada versi 2.8 dan 2.9 Anda dapat menginstal tema dengan 

mengambil jalan Penampilan -> Tambah Tema Baru dari panel administrasi Anda, dan 

jika Anda memiliki Wordpress 3,0-3,4 - dengan memilih tab baru "Install Themes" 

di Appearance -> Tema - > Instal Tema.Untuk menginstal sebuah tema Wordpress, ikuti 

langkah-langkah di bawah ini:  

1. Ekspor tema WordPress Anda dari Artisteer sebagai file zip; 

2. Login ke panel administrasi WordPress Anda dan pilih Appearance -> Tema; 

3. Beralih ke "Instal Tema" tab (di WP 3,0-3,4) atau pilih "Add Tema Baru" (di WP 2.8, 

2.9); 

4. Gunakan link Upload di menu atas untuk meng-upload dan menginstal salinan zip dari 

tema diekspor dari Artisteer. 

 

 

http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://codex.wordpress.org/Using_Themes&usg=ALkJrhhA6Hb_WsV7sZUK-Wof7_lzASngFA#Adding_New_Themes
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Gambar 81 : Form upload template 

 

Setelah aktivasi, Anda akan melihat pesan berikut:  

 

 

 

 

o Klik tombol "Add Content" tombol jika Anda mengimpor konten untuk pertama 

kalinya. 

o Klik "Ganti Konten Impor" tombol jika Anda telah diekspor kembali tema dari 

Artisteer (misalnya, dengan artikel diedit). 

 

Catatan: Jika Anda ingin mengimpor konten, silahkan mengaktifkan "Sertakan Konten" di 

Artisteer sebelum mengekspor tema.  
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WordPress Widget Area 

 

 

Gambar 82 : Design widget 

Dimulai dengan Artisteer 4.1 penciptaan Footer Area Widget didukung.   

Posisi gaya, ditampilkan sebelumnya, adalah salah satu default. Anda dapat mengubahnya 

sendiri juga. Untuk ini, silahkan lakukan hal berikut: 

1. Pergi ke Penampilan -> Widgets dan memilih widget yang ingin Anda edit. 

2. Klik "Edit". 

3. Di bawah Opsi Tema -> Appearance pilih penampilan widget yang sesuai: sebagai sisa 

sidebar, sebagai blok, sebagai posting atau sebagai teks sederhana. 
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Gambar 83 : Theme Option 

 

Menambahkan Widget untuk header 

Di Artisteer 4.0 Anda dapat menambahkan widget ke Header dan posisi mereka dengan 

kode CSS.Silakan ikuti langkah-langkah di bawah ini: 

1. Pergi ke Penampilan -> Widgets dan menambahkan widget ke Widget di Area 

header.Widget Anda akan muncul di sudut kiri atas Header. 

2. Gunakan perangkat debug seperti Mozilla Firebug untuk mendefinisikan dan menyalin 

id widget. 

3. Buka Penampilan -> Editor dan gulir ke bawah file. Paste id widget diawali dengan # 

(tanda nomor) dan ketik posisi CSS yang sesuai, misalnya: 
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 # Search-1  

 { 

 top: 20px; 

 kiri: 50%; 

 } 

 

 

Membuat Menu Vertikal 

Anda dapat menambahkan menu vertikal dari Administrasi WordPress (untuk sidebars 

dinamis) dengan pergi ke Penampilan -> Widgets -> Menu Vertikal.  

 

Setelah menambahkan menu Anda dapat memilih sumber dengan menekan "Edit" dan 

menetapkan sumber sebagai "Halaman", atau "Kategori", atau "Custom Menu".  

 

 

 

 

Gambar 84 : widget vertical menu 
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Pengelompokan Vertikal Menu Produk 

Item di Menu vertikal dapat dikelompokkan berdasarkan jenis item menu khusus yang 

disebutseparator. Untuk item menu seperti URL tidak ditugaskan, yang berarti mereka 

tidak link ke halaman web tertentu, tetapi berfungsi sebagai daftar item yang nama 

kelompok tertentu link.  

 

Mulai dari versi 3.0 Beta 2, Artisteer template untuk mendukung WordPress Menu 

Vertikal dengan pemisah. Untuk mengaktifkan menu pemisah, silahkan update Artisteer, 

membuka proyek. ArtX Anda, re-ekspor template dan menerapkannya ke WordPress.  

 

Untuk membuat custom Menu Vertikal dengan pemisah: 

1. Buat / Buka kustom Menu Vertikal di Dashboard -> Appearance -> Menu -> [kustom 

nama menu]. 

2. Pergi ke "Custom Links" blok, masukkan simbol # di bidang URL dan nama 

separator(pemisah misalnya saya 1). Tekan "Tambah Menu" dan melihat pemisah yang 

baru dibuat dalam daftar dengan item Menu Vertikal lainnya. Lanjutkan prosedur untuk 

menambahkan item menu pemisah. 

 

 

Gambar 85 : menu di wordpress 
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3. Buat item menu baru atau drag dan drop item yang ada untuk menempatkan mereka 

dalam item menu pemisah. Tekan "Simpan Menu" dan pergi ke website Anda untuk 

memeriksa Menu Vertikal. 

 

 

Gambar 86 : Display menu 

 

Menyesuaikan Halaman khusus 

"Tampilkan widget pada ..."  

Anda dapat memilih untuk menampilkan widget pada halaman tertentu dengan opsi 

baru"Tampilkan widget pada ...". Untuk melakukannya, ikuti langkah-langkah berikut:  
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1. Pergi ke Penampilan -> Widgets dan memilih widget yang ingin Anda tampilkan pada 

halaman tertentu. 

2. Klik "Edit" dan di bawah "Pilihan tema" memilih untuk menampilkan widget pada 

semua halaman kecuali halaman yang dipilih atau menentukan halaman mana widget 

ditampilkan. 

 

 

 

 

Gambar 87 : Theme Option untuk All page 

 

 



92 
 

Membuat Halaman Berbeda Tata Letak  

 

Di Artisteer 4 Anda dapat menyesuaikan halaman tertentu pilihan tata letak seperti apakah 

untuk menunjukkan dalam menu, atau untuk menunjukkan header pada halaman ini dll  

Untuk menyesuaikan halaman tertentu:  

 

1. Pergi ke Administrasi Wordpress -> Pages. 

2. Pilih halaman tertentu dari daftar dan klik "Edit". 

3. Menyesuaikan fitur halaman di bawah "Tema Options". 

 

 

 

 

Gambar 88 : Theme Option penyesuaian halaman 
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Mengatur header Images Berbeda  

 

Mulai dari Artisteer 4 Anda dapat mengatur gambar header yang berbeda pada halaman 

yang berbeda. Untuk melakukan hal ini, ikuti langkah-langkah di bawah ini:  

 

1. Pergi ke Administrasi Wordpress -> Pages. 

2. Pilih halaman yang ingin mengatur gambar header khusus pada, dan klik "Edit". 

3. Klik "Set header image" di bawah "Halaman Header Image". 

4. Memilih dan meng-upload gambar. 

5. Sesuaikan keselarasan, ukuran dan pilihan gambar lainnya, mengedit gambar, jika 

perlu. 

6. Klik tombol "Simpan semua perubahan" tombol. 

 

 

Gambar 89 : Setting Header Image 
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Menciptakan lokal Wordpress Themes dengan Artisteer 

Ketika mengekspor Artisteer tema otomatis mencakup beberapa file bahasa diperoleh dari 

Website Wordpress di http://codex.wordpress.org/WordPress_Localization  

 

Secara khusus Perancis, Jerman, Italia dan Spanyol terjemahan yang diekspor oleh 

Artisteer dalam file sesuai Format Wordpress penamaan:. <country> _ <lang> Mo  

 

Misalnya file bahasa Jerman adalah: de_DE.mo  

 

 

Instalasi dukungan bahasa tambahan 

Untuk menyertakan dukungan bahasa yang berbeda atau tambahan dalam tema Worpdress 

Anda silahkan mencari dan menyalin file bahasa yang diinginkan ke dalam folder khusus 

tema Wordpress Anda.  

 

Anda dapat menemukan file bahasa tambahan dalam folder tema default Anda  

"<WordPressFolder> \ Wp-content \ tema \ default",  

 

atau di Website Wordpress di http://codex.wordpress.org/WordPress_Localization .  

 

Untuk memilih bahasa yang berbeda dari bahasa Wordpress Anda saat ini, mengubah 

"mendefinisikan" fungsi dalam file wp-config.php, misalnya: define ('WPLANG', 

'de_DE').  

 

Mengedit terjemahan 

Untuk mengedit terjemahan untuk bahasa Anda silahkan download dan install Codestyling 

Localization plug-in dari http://wordpress.org/extend/plugins/codestyling-localization/ .  

 

http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://codex.wordpress.org/WordPress_Localization&usg=ALkJrhiiBH275Y7-_I-4mtsfuh4OVHdy-Q
http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://codex.wordpress.org/WordPress_Localization&usg=ALkJrhiiBH275Y7-_I-4mtsfuh4OVHdy-Q
http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://wordpress.org/extend/plugins/codestyling-localization/&usg=ALkJrhgj0D6QvdU3qWmuA3YvAgsYkQq9nA
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Kemudian di Wordpress administrasi pilih Manage -> Lokalisasi.  

Menyesuaikan Footer 

Mulai dari Artisteer 3.0 teks boneka footer dapat disesuaikan secara langsung di Artisteer 

(Footer> Text ... dialog). Teks ini tidak akan muncul di website Anda. Untuk mengubah isi 

Footer Anda pergi ke Administrasi WP -> Appearance-> Options Theme -> isi Footer.  

 

Dimulai dengan versi 4.1 Artisteer menghasilkan daerah widget footer oleh sel Tata Letak 

Konten di Footer.  

Untuk kompatibilitas dengan tema yang dibuat dengan versi Artisteer sebelumnya, "lama" 

footer widget area tata letak juga disimpan dalam tema WP diekspor dari Artisteer. Untuk 

beralih ke "tua" footer layout:  

 

1. Silahkan menavigasi Dashboard WP -> Appearance -> Tema Pilihan -> Footer. 

2. Periksa "Override tema default footer konten" pilihan: 

 

 

Gambar 90 : Default Footer 
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Bab 10 

Setting Web Template Artisteer pada Drupal 

 

Merancang Drupal Tema dengan Artisteer 

Drupal adalah salah satu sistem manajemen konten terkemuka untuk mengatur dan 

menampilkan konten website. Dengan Artisteer Anda langsung 

merancang tema profesional Drupal tanpa keterampilan pemrograman atau mengetahui 

Photoshop, Dreamweaver, HTML, CSS dan teknologi desain web lainnya. Artisteer 

memungkinkan Anda untuk mengambil kontrol atas desain website Anda, dan mengelola 

dan menyesuaikan tema Anda dengan selera Anda. Berikut adalah beberapa langkah 

tentang cara cepat membuat sendiri tema unik Drupal Anda: 

1. Mulai Artisteer dan  klik  "Suggest  Design" tombol beberapa kali, sampai Anda 

melihat sebuah ide yang Anda suka.(Menggunakan  "Undo"  dan  "Redo"  tombol  

untuk  mencari  ide-ide  yang dihasilkan belakang  dan  ke  depan)     

 

Gambar 91 : memilih ide design 
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2. Memodifikasi elemen desain tema, termasuk tata letak, header, latar belakang, font, 

dan banyak lagi.  

 

 

Gambar 92 : Memilih tata letak 

3. Ekspor tema Anda, kemudian upload file tema ke dalam folder tema yang baru dibuat 

dalam situs web Anda.  

 

 

Gambar 93 : Eksport ke Drupal theme 
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4. Di Artisteer 4 Anda juga dapat mengekspor konten tema untuk Drupal. Untuk ini 

silahkan aktifkan "Sertakan Konten" sebelum mengekspor tema.  

 

 

Gambar 94 : menyertakan content 

5. Dalam Administrasi Drupal (Administrasi -> Appearance -> Tema) meng-upload 

tema Anda dan pilih dari daftar tema yang tersedia.  

 

 

Gambar 95 : Install new theme 
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Instalasi Drupal Tema 

1. Akses server Web Anda menggunakan klien FTP atau alat administrasi server Web. 

2. Buat folder untuk tema tertentu Anda di bawah "<YourSiteFolder> / themes /" folder 

dalam instalasi Drupal.  

Sebagai contoh: <YourSiteFolder> / themes / <MyNewTheme> 

3. Menyalin atau meng-upload file tema diekspor dari Artisteer ke 

folder <MyNewTheme> baru dibuat. 

4. Login ke Administrasi Drupal Anda. 

5. Pergi ke Drupal Administration -> Appearance  

(Www.YourSite.com/?q=admin/appearance) 

6. Pilih tema Anda baru di-upload dari daftar yang tersedia untuk tema situs Anda. 

7. Klik tombol "Simpan konfigurasi" tombol untuk menyimpan perubahan Anda. 

Dalam Drupal 7 ada cara alternatif untuk menginstal tema Artisteer baru melalui Drupal 

Administration -> Appearance -> Install New Theme, seperti yang ditunjukkan pada Design 

Drupal Tema dengan Artisteer (langkah 5).  

Setelah menginstal silahkan pergi ke Drupal Administration -> Appearance, mengaktifkan dan 

menetapkan standar tema.  

 

 

 

Gambar 96 : Install new theme 
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CATATAN: Jika Anda ingin menambahkan konten ke situs web Anda, jangan lupa untuk 

beralih "Impor Konten" sebelum mengekspor template dari Artisteer.  

 

Untuk mengimpor konten dari Artisteer silakan ikuti langkah berikut:  

 

1. Browse folder tema tertentu Anda dalam Drupal instalasi situs navigasi \ semua \ tema.  

Sebagai contoh: <DrupalFolder> \ situs \ semua \ tema \ <YourThemeName>. 

2. Cari art_content.zip dan unzip ke folder. 

3. Pindahkan folder art_content unzip ke situs \ semua \ modul. 

4. Pergi ke Drupal Administration -> Konfigurasi -> Content Authoring -> Artisteer Konten 

Impor. 

5. Aktifkan "Artisteer Konten Impor" dan klik "Impor" tombol. 

 

 

Gambar 97 : Import Content Artisteer 
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CATATAN: Ketika menginstal template Artisteer ke Drupal untuk pertama kalinya, mohon 

aktifkan modul untuk konten Artisteer impor di Drupal: 

1. Pergi ke Administrasi Drupal -> Modul. 

2. Aktifkan "Artisteer Konten" modul di bawah "Lainnya" tab. 

3. The "Artisteer Konten Impor" pilihan akan muncul di bawah Konfigurasi -> Content 

Authoring. 

 

 

Gambar 98: Konfigurasi module drupal 

Untuk informasi lebih lanjut silahkan kunjungi: http://drupal.org/node/456  

 

Memanfaatkan Menu 

Silakan gunakan langkah-langkah berikut untuk memanfaatkan gaya menu yang dirancang 

dengan Artisteer: 

http://drupal.org/node/456
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1. Pergi ke Drupal Administration -> Struktur -> 

Menu (www.YourSite.com/?q=admin/structure/menu) 

2. Mengedit menu yang ada atau membuat yang baru. 

3. Periksa "Expanded" pilihan untuk item menu induk jika Anda ingin membuat drop down 

menu horizontal (akan <MenuName> -> link daftar -> <menu link> -> edit). 

 

 

Gambar 99 : List Link 

 

4. Pergi ke Drupal Administration -> Struktur -> 

Blok (www.YourSite.com/?q=admin/structure/block) 

5. Tempatkan menu ke "Menu" wilayah. Jika Anda ingin mengkonfigurasi menu vertikal, 

pilih"Vertikal menu" di wilayah sidebar kiri atau kanan. 
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CATATAN: "Menu" daerah hanya dapat berisi satu menu, atau tidak ada.  

Untuk informasi lebih lanjut silahkan kunjungi http://drupal.org/node/102338  

 

Menyesuaikan Footer 

Dimulai dengan Artisteer 4 footer dianggap bagian dari isi website dan dapat diimpor bersama 

dengan konten website lain.  

Atau (atau jika Anda tidak mengimpor konten dari Artisteer) Anda dapat menyesuaikan footer 

tema melalui Drupal Administrasi menempatkan satu atau beberapa blok ke tempat "Hak Cipta"  

Berikut adalah contoh langkah-langkah untuk mengkonfigurasi kustom footer: 

1. Pergi ke Drupal Administration -> Struktur -> Blok (www.your-

site.com/?q=admin/structure/block) 

2. Klik "Configure" di samping Footer dan mengedit bidang tubuh Blok. 

3. Klik tombol "Simpan blok" tombol untuk menyimpan perubahan Anda. 

 

Menambahkan Modul untuk header 

Artisteer 4.0 template mendukung modul di Header. Gaya dan posisi modul dapat disesuaikan 

dengan kode CSS. Silahkan ikuti langkah-langkah berikut: 

1. Menambahkan modul untuk header dengan menugaskan ke daerah header. 

2. Buka folder template Anda dan tambahkan kode CSS yang mirip dengan file style.css: 

 Art-header>. Wilayah.,. Seni-header>. Blok { 
       top: 20px; 

       kiri: 50%; 

     } 

3. Untuk posisi blok-blok individual, menggunakan perangkat debug seperti Mozilla Firebug 

untuk mengetahui ID blok. Kemudian tambahkan kode CSS berdasarkan ID: 

  # BlockID { 

       top: 20px; 

       kiri: 50%; 

} 

http://translate.googleusercontent.com/translate_c?depth=1&hl=en&ie=UTF8&prev=_t&rurl=translate.google.co.id&sl=en&tl=id&u=http://drupal.org/node/102338&usg=ALkJrhiRnLcfRs0hhnwVZuxex_zlZNFmIA
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